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Welcome to our WordPress Web Site Creation Course -
Learning how to create a website from scratch with WordPress.

Creating a website can be both a fun and tiring task, however the
results are always rewarding!

In my years of experience creating websites for both my clients and
my own businesses, | have developed a systematic approach In
designing and creating websites.

Introduction

It you follow through step by step, you will be able to get a basic
WordPress website set up and running by the end of this course.

A demo website will be provided for practical hands-on, and you
will be able to take home the website for practice during your own
free time.

Without further ado, let's get started!
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3 Essential Elements to Build a Website

(1) Domain Name

Web Host

Web Application Framework
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How Is It All Connected?

|. Domain Name =
2. User gets “redirected” to where your -
_—

hosting server IS located.
2 —— )

. - User

You

Web Browser

1. User types In www.example.com
IN his web browser

2. Hosting Server

3.CMS Resides Here ——

3. Website files get downloaded from :
your hosting server to be displayed onto HOStlng
. his web browser. Server
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What IS a

A Content Management System is a web

application for non-technical users to create ana
edit web content, manage, and customise a website
with ease.
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Some Open Source & Proprietary CMSes

WORDPRESS

% Telerik

Develop experiences

Joomlal
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Open Source CMS vs. Proprietary CMS

Open Source CMS Proprietary / Closed Source CMS

Support: Due to a larger user base, it is

generally easier to find solutions to common
problems on the web.

£
N 4
Customisation: Less costly to customise but Propmetary
may be more costly If advanced customisation CMS

Support: Dependent on how reliable and
proactive the developers are.

Customisation: Unless CMS is built purposely
for a specific niche, advanced customisation

s required Open may be required and is usually quite costly.
Source
, o Costs: Generally more expensive to maintain
Costs: Generally less expensive to maintain CMS

than open source systems. Some vendors
charge yearly licensing fees.

than proprietary systems.

I Security: Dependent on how consistent
| security updates are launched for the core
system and third party plugins.

O Security: Generally believed to be more secure
' due to obscurity of the code. But also
dependent on consistent security updates.

\ Portability: Easier to move from on platform
' - or web host to another.

N7 , Portability: Exporting data may be tricky and
& may require expertise from original developer.

Read More: http://www.bloomtools.com/articles/open-source-vs-proprietary-cms.html
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Google Search Trends

52

Joomlal

WORDPRESS O Drupal’
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WORDPRESS.ORG

@ WordPress.com

WordPress.ORG

Free to download WordPress software. However

COSJ[ domain name and web hosting is not i.ncluded..
You need to purchase your own domain & hosting
and install WordPress software on your own.

Able to customise core files i.e. PHP, CSS, install

CUStOmisatiOﬂ third party themes, and plugins to extend

functionality of site.

Backing up and updating your site, preventing

Mai ntenance spam, and enforcing site security is your

responsibility. Only forum support available.
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WordPress.org vs. WordPress.com

WordPress.COM

Free to sign up with sulbdomain and web hosting
iIncluded. Paid upgrade options available i.e. TLDs
(.com & .net.), space upgrades (>3gb), and more.

Plugins are not available for installation. Unable to
customise core files unless you pay for upgrades.

Security and backups are included. Personal
support and forum supports are available.

WordPress Website Creation Training Course



INntroduction to

Domain

&
Web Hosting

»
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INS ramecheap  Asia ’;’

webvisions

Asia’s Trust Hosting Provider

vod:en

internet solutions
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SUPPORT ~ SIGNIN ~ SIGN UP S up~- PO

N namecheap Domains ~ Hosting -~ Apps - Security -~ Account ~

Bulk Options

Buying a
Domain

D., "l New around here? m
. \ Find exactly what you need with our custom tailor tool

Namecheap for Business Resellers

Create your pro web presence in no time.

Name From
Namecheap

1. Navigate to www.namecheap.com
2. Think of a domain name and enter your domain name into the domain name search
DOX.
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http://www.namecheap.com

SUPPORT ~ SIGNIN ~ SIGN UP

N namecheap Domains - Hosting - Apps - Security - Account -

Domains — Registration — Results

2y g2 s Subtotal $0.00
This domain is available! $10.69/year

1. Click the “add to cart icon”
2. Click “View cart”

appleskitzers.com Bulk Options Search View Cart

Search Results

Popular International @ Suggestions W Favorites Click here to

> appleskitzers.com $10.69/yg§
) appleskitzers.xyz LIMITED TIME! 51.00/year
Reg. Price $9.88/year

appleskitzers.club WELCOME TO THE CLUB $1.88/year

Reg. Price $10.88/year
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Domains -~ Hosting - Apps - Security - Account -

SEET e [ Click Confirm
ulk Settings ~ itCart ~

| Order e Your Subtotal
Domain Registration ' 1 Year - $10.69 & \Jbtotal $10.87
appleskitzers.com ——
ICANN fee 50.18 Confirm Order ’
X AUTORENEW OFF

Promo Code
Free WhoisGuard 1 Year - 288 $0.00 X
for appleskitzers.com | FREE!
X AUTORENEW OFF m
v WHOISGUARD ON
Improve Your Site 2
|5

1. Visit
WWW.namecheapcoupons.co

m to get a promo code
2. Click “Confirm Order”
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Log In to Your Account SIGN UP? Create An Account LOG IN?

New to Namecheap? Quickly signup for an account now.

Username
Username
Password
Password
: Confirm Password ’assword 1 . Create an ACCOUHT |f yOU
orgot username or password? ,
don't already have one
st Name il 2. Log in to your account if you
already have one
Last Name
Email Address

« Yes, sign me up for Namecheap's newsletter

By creating an account, you agree with our Terms of Service.

Create Account and Continue
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Subtotal $0.00

First Name Apple
Last Name Skitzers
Company Name

Job Title

« I'm registering on behalf of a company

1. Fill in your account contact
Address Line 2 |nf0rmat|0ﬂ
2. Click “Continue”

City
State/Province

Zip/Postal Code

Country ' Select Your Country

Phone Number

) Add phone extension
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Secure Card Payment - B E appleskitzers.com
1 year registration 51069

Your credit card information is secure, and your card is not charged until after you've confirmed your order. Adding a new ICANN fee $0.18
card? Learn More

Subtotal $10.87

Card Details

Name on Card

Card Number

Select =7 1. Select and enter preferred
preferred _,...on w1 payment method
payment 2. Click “Continue”

methOd Card Billing Address i Use default account contact v '

Apple Skitzers tel: +65.91293821

blk 601, Woodland Drive 42, #02-73, chanc62682@gmail.com
S{730601)

Singapore, NA, 730601

SG

v Remember this card for later use

-y Account Funds
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Recently Active in Your Account

Expiring Soon All Products Expiration

demowebsite21.space nv v Dec 6, 2016 MANAGE
WhoisGuard

Domain List

Product List demowebsite20.space e v Dec 6, 2016 MANAGE 1. Once you have bought your
e domain name, navigate to
your account dashboard.
2. YOU can manage your domain
names from your account
demowebsite19.space B v Dec 6, 2016 MANAGE dashboard

demowebsite18.space Ao v Dec 6, 2016 MANAGE
WhoisGuard

WhoisGuard

demowebsitel6.space hq g Dec 6, 2016 MANAGE
@+ ADD CATEGORY WhoisGuard

View all domains

Q
©
O

e
O
®
=
©

Z
-
O

I
®
=
©

Z

=
©
-
O

A
©
O

=
>
D

M

3

N

Q3
N

>

Equinet WordPress Website Creation Training Course
Academy 19




© SiteGround m

wpengine  @)DreamHost

vodlen

internet solutions

HostGator,;
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Types of Hosting Plans

For websites which do not For web design providers For high server resources, For resource-intensive
require high server resources who wish to manage faster data transfer & data dynamic pages, database,
& want to save cost. hosting for clients. Isolation requirements. or emall services.

Shared Hosting Reseller Hosting VPS Hosting Dedicated Server
Shared with many Shared with many Allocated server Dedicated server
users users resources resources
Shared bandwidth Shared bandwidth Allocated bandwidth Allocated bandwidth
Shared or allocated Allocated disk Allocated disk space Allocated disk space
disk space space

Able to create Able to create
One cPanel Able to create multiple cPanels multiple cPanels
multiple cPanels
Able to scale up Root-level access
~ $10/mth A ~ $30/mth A ~ $80/mth A ~ $200/mth A

S
\
N

N
Equinet WordPress Website Creation Training Course

Academy 21



A content delivery network (CDN) is a system of distributed servers
(network) that deliver webpages and other Web content to a user
based on the geographic locations of the user, the origin of the
webpage and a content delivery server.

= Servers
& Human
Equinet

Academy 22

Benefits of a CDN

Improves content delivery speed and
performance across various
geographical regions

Saves cost compared to investing in
an infrastructure of web hosting
servers across the globe

Pre-cached web files still deliver to
users globally even in cases of
power outages or downtimes on the
main server

WordPress Website Creation Training Course



@ Si‘l’@GFOUﬁd 1.866.605.2484 " LiveChat X Login

Home  Web Hosting  WordPress Services  Joomla Services  Our Technology  Our Support  About Us  Affiliates

Buying 9 WEB HOSTING

CRAFTED WITH CARE

We b Web hosting is our craft. Latest speed technologies are our
passion. Unique security solutions are our specialty. Amazing

technical support is our pride.

Hosting T .
Package

1. Navigate to www.siteground.com
2. Select “Sign Up”
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Step 1. Choose Plan

©

StartUp

Crafted for Great Web Start

60% OFF THE REGULAR $9.95/MO.

$3.95/mo.

One Website
10GB Web Space
10,000 Visits Monthly

*

GrowBig

Crafted for Your Web Growth

45% OFF THE REGULAR $14.95/MO.

$7.95/mo.

Multiple Websites
20GB Web Space
25,000 Visits Monthly
All Essential Features

O

GoGeek

Crafted for Real Web Geeks

50% OFF THE REGULAR $29.95/MO.

$14.95/mo.

Multiple Websites
30GB Web Space
100,000 Visits Monthly
All Essential Features

1. Choose a web hosting
package of your choice

2. Click “Order Now”
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Step 2. Choose Domain

Please Enter Your Domain

(O Register a New Domain 1. Select “| already have a
Domain”.

2. Enter your domain name that
you've purchased earlier on.

WWW. appleskitzers.com 3. Click "Proceed”.

@) | already have a Domain

Website Transfer: FREE (Save $30.00)
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Purchase Information

85 Hosting Services

Plan: GrowBig &)

Data Center: Singapore (SG) &)

Period: Trial: 1 month $7.95 + $24.95 setup v
Hosting Price $7.95 (Regular: $14.95) (Now bill $32.90)

* You save 45% on the regular $14.95/mo for the first invoice. Once your initial term is over regular renewal prices apply.

% Extra Services

+" Website File Transfer FREE (Save $30.00)

We offer a free website migration service to save you time and hassle when switching
hosts.

+" SSL certificate for 1 year FREE (save $82.00)

& An SSL certificate authenticates and encrypts the data transferred through the website
to the server, protecting financial and other sensitive information.

HackAlert Monitoring $12.00/year

g HackAlert is 3 monitoring service that checks your website daily and immediately
notifies you if your website has been hacked or injected with malicious code.

TOTAL: 32.90 USD

¥ | confirm that | have read and agree to the SiteGround Terms of Service.

26

1. Enter your detalils.

2. Click “Pay Now”.

3. You will receive your web
hosting details through email.
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How to Point/Link Domain Name to Website

Step 1

Once you have bought your web
hosting package, your web hosting
provider will send you the Name
Server details i.e.
(ns1.hostingprovidername.com and
ns2.hostingprovidername.com).

Step 3

That's it! Wait 24 to 48 hours
for propagation before your

Step 2 website will start working.

Login to your domain name registrar
and find the registrar settings of your
domain to input the name servers
Into. It should be something like
“Manage DNS servers” or “Configure/
transfer DNS servers”.

n:.'
N

N
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() Expiring Soon

9 Domain List

‘1\1 Product List
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Recently Active in Your Account

All

demowebsite2l.space

demowebsite20.space

demowebsitel8.space

demowebsitel9.space

demowebsitel6.space

View all domains

Products

ﬁ:’-]

R
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Expiration

Dec 6, 2016

WhoisGuard

Dec 6, 2016

WhoisGuard

Dec 6, 2016

WhoisGuard

Dec 6, 2016

WhoisGuard

Dec 6, 2016

WhoisGuard

MANAGE
MANAGE
MANAGE

MANAGE

1. Navigate to your

Namecheap dashboara

2. Find the domain name
you wish to modify and
click “Manage”
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Dashboard Domains —

(> ExpiringS -
S S el S demowebsite21.space
B (B =e
Products Sharing & Transfer Advanced DNS
Product List
G Dec 6, 2015 - Dec 7, 2016

AUTO-RENEW

Dec 6, 2015 - Dec 6, 2016

PROTECTION AUTO-RENEW

Click here and select
“— “Custom”

e Namecheap Default ) 4

./ WhoisGuard™ @

e Your domain is using custom DNS servers, which means you can redirect a
domain in cPanel. Before you set up Email Redirect here, your domain should be
pointed to our default DNS. For detailed instrcutions refer to our Knowledgebase

article —

Qy
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ADD YEARS

1. Under "Nameservers”,
click "Namecheap
Default”.

2. Select “Custom”.
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@3 Dashboard

{~) Expiring Soon

Wg Product List
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demowebsite2l.space

¢ WhoisGuard™

B B e
Products Sharing & Transfer Advanced DNS

Dec 6, 2015 - Dec 7, 2016

Dec 6, 2015 - Dec 6, 2016
Enter your
el ~  nameservers here v +x-

ADD YEARS

1. Enter your name servers
into the blanks. (Your
hosting provider will email
you the name server
details)

@ ADD NAMESERVER

Your domain is using custom DNS servers, which means you can redirect a
domain in cPanel. Before you set up Email Redirect here, your domain should be
pointed to our default DNS. For detailed instrcutions refer to our Knowledgebase

article —

30

2. Click on the green
checkbox and wait 24 -
48 hours for propagation
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l x IEHIGI' Yyour username.

[ K} Enter your account password.
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1. Navigate to www.yourdomain.com/cpanel
. Enter your login detalls
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Site Improvement Tools A

£

e O ()
- CloudFlare SuperCacher SG-Git SiteApps
- Dashboard
D
@)
@
<CEJ WordPress Tools RN
O @ W
WIS g - | L)
"(_7') WordPress WP Auto WordPress SuperCacher Staging SG-Git ManageWP
O Installer Update Toolkit
1
2 — = | .-} 1. Once logged in to your

oom 00IS A" :

== | 5 R P cPanel dashboard, click
e x a 6“ ﬁ g ......... “Email Accounts” to set up
>Cz Joomia! Jo.om‘lé! Joomia! SuperCacher Staging SG-Git ...t your emall domalns.
- Installer Auto Toolkit et
— Update et
s et
| s OL A Mail o~
UEJ ........ =g "
D Emall Webmall Spam Forwarders Auto Default Account User Level Import
@) Accounts Assassin™ Responders Address Level Filtering Addresses/
- Flltering Forwarders
s = A2 A O

Emall MX Entry Advanced SpamExperts

Authentication MX Editor
S
Equinet WordPress Website Creation Training Course
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CPANEL N

i_] Email Accounts

This section allows you to manage the email accounts that are associated with your domain. e 1. Create Your Email Account
Important: Please note that setting up a mailbox with unlimited (0 MB) quota is not allowed as per the service's Terms of Use. The maximum | [N, - ° ° . 2 Cl |Ck . More” and access your
mailbox quota allowed for your hosting package is: 1000 MB S .
....... wepbmalil
Emai: o damowsbatientatie. - L L N
Password: | | " Refer to www.equinetacademy.com/

how-to-connect-cpanel-email-
account-to-gmail/ on how to
connect cPanel email to gmaill.

Alternatively, it would be
recommended to subscribe to

c
)
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S
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Q
D
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[SAear_d_\_ _Email_" ‘Search Email I Results Per Page: I 10 ::.I
Google Apps to set up and access
Account @ Domain Usace / Quota / % AcTIONS :
. your company emalils through
admin@demowebsite31.site 1 250:0018 Change: s Delete: [Hasl Gmail. https://apps.google.com/
|| Access weomail
Default Email Account (?) Configure Emall Client
P — Bhencn P e Z-;,-;;,-,;;-T_' e+
S
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Accounts Assassin™
= A A
Emall MX Entry Advanced

Authentication MX Editor

ﬁ

HTTP CPU Cron CPU HTTP
Usage Usage Memory
Statistics Statistics Usage
Statistics
Fille  glegacy Flie Disk Space
Manager Manager Usage

\ . e ‘
Musal RN AN

n

Responders Address Level Filty
Filtering
SpamExperts
1H Software
M e
Cron HTTP I/O Cron 1/O Quota P
Memory Usage Usage Statistics Vel
Usage Statistics Statistics Mar
Statistics
F"es .................
@
FTP FTP Session Anonymous
Accounts Control FTP
Databases

'EAN\

My =

@ g ==

MySQL® MySQL® phpMyAdmin Remote PostgreSQL PostgreSQL phpPgAdmin
Databases Database MySQL Databases Database
Wizard Wizard
34

1. Access your website files via
File Manager

WordPress Website Creation Training Course



c
)
O
O
O
<
)
=
1%
O
1
fo!
=
S
>_
=
L%,
©
-
L]
Q
D
®)
=
o
N

Directory Selection

Select the directory that you wish to open:

~ Ry Home Directory

(o W Web Root (public_htmiwww) | <

" ' Document Root for:
[ demowebsite56.site 3]

L T

Show HiddenFilés (dotfiies) s
| Skip this question, and always open this directory in the future when |
choose to open “File Manager”.

Go I n LR T

= | v g wj
File Legacy File Disk Space FTP FTP Session Anonymous
Manager Manager Usage Accounts Control FTP
Databases
- - - e P .-

Account l
Level
Filtering

.:.
N
N
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1. Ensure you have select Web
Root (public_html/www). This
IS where the public can view
your files on the World Wide
Web.

2. Ensure you have checked
“Show Hidden Files
(dotfiles)”. This is will reveal
any hidden files such
as .htaccess.

............... 3 Click “Go”.
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File Manager settings
* -~y N - ~- 3 ' - o " {
= O W6 4 = 3 9 %8 N Z &2 @m s W € €
New File New Copy Move File Upload Download Delete Rename Edit Code HTML Change View Extract Compress
8 Folder Editor  Editor  Permissi...
O : <
<LE) /"/1 public_htm| I ............. Go. ..., a9 .Home . |t Up One Level <2 Back & Forward - Reload || Select All Unselect All
B
) £= Collapse Al Neme 0 TTTITIIIITTrteteeedeeena., 1. Ensure you are on Web Root
(- This directory is empty. : S
= A —— (pubhc_html/wva). This is
O B8 .autoupdate wherg the public can view
- = DA your files on the World Wide
O Sd.cphorde | e Web.
% S ohtpasswds | e
= 3 .softaculous """ 2. This is the area where you
= s manage your website files
= S SRCCOIntE such as your photos, videos,
D . .trash :
S plugins, themes, WordPress
E Hidetc fil
LL] d logs core TlesS.
O - ‘J mail
D)  perl5
g) ~3 14 public_ftp
+— | U public_html
C% dtmp
s
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Domains A

@ & &

s @ &

Subdomains Addon Parked Redirects Simple DNS Advanced
Domains Domains Zone Editor DNS Zone
Editor
Autolnstallers A
- /—‘\ :\"‘..
& B ® w Vi =
i \A/ > PRES A
Site Joomla WordPress Magento CSCa PrestaShop
Software Application
3 tep
||
Site Improvement Tools A
WordPress n O 2
CloudFlare SuperCacher SG-Git SiteApps

Dashboard

Installation

1. Under “Software and Services” of your cPanel home, click on either one of the
following
« Softaculous (We will be going through Softaculous in the next steps)
* Quick Install
* Fantastico
The above softwares vary depending on your web hosting provider.
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Top Scripts

(™,

WordPress AbanteCart

1. Click on WordPress to go to
' 228 s ' 288 e

the next screen
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PrestaShop Joomla
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@n WordPress

* A KXKXYr  Version:4.53

Release Date : 21-06-
2016

‘ Qverview Features Screenshots Demo  Ratings Reviews Import

say that WordPress is both free and priceless at the sametime. [ Ttteeenl o SN ”
1. Click “Install” and go to the

The core software is built by hundreds of community volunteers, and when you're ready for more next screen.

there are thousands of plugins and themes available to transform your site into almost anything

you can imagine.

Over 60 million people have chosen WordPress to power the place on the web they call "home”
we'd love you to join the family.
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WordPress is an Open Source project, which means there are hundreds of people all over the
world working on it. (More than most commercial platforms.) It also means you are free to use it for
anything from your recipe site to a Fortune 500 web site without paying anyone a license fee.

Install Now My Apps
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Software Setup

Choose Protocol http://

<)

If your site has SSL, then please

choose the HTTPS protocol.
Choose Domain

<)

demowebsite31.site
Please choose the domain to install

the software.

In Directory

The directory is relative to your
domain and should not exist. e.q.

To install at http://mydomain/dir/ _ ,
just type dir. To install only in 1. Choose the domain yOu wish

http://mydomain/ leave this empty. to install WordPress on

Site Settings 2. Enter your Site Settings

Site Name My Blog
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Site Description My WordPress Blog

Enable Multisite (WPMU) ©® ()

Admin Account

N
N
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N
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Admin Password

Admin Email

Choose Language

Select Language

Select Plugins

Limit Login Attempts (Loginizer) @

Clef Secure Passwordless Login €

Choose Theme

Choose a Theme to install

E3 Advanced Options

21#6HEN7@$
Strong (60/100)

admin@demowebsite31.site

English

None

Install

Hide

<)

<

4]

1. Fill in your admin details

2. Click “Install”
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Username

Password

Remember Me

Lost your password?

+ Back to Demo Site

42

You can NnOw access your site
through
www.yourdomain.com/wp-admin

1. Enter your login details
2. Click “Log In”
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W @A DemoSite B 4+ New Howdy, demouser i

I can tell, Dolly Screen Options Help
£ Dashboard Dashboard
Home
Updates T—
Welcome to WordPress! o
- We've assembled some links to get you started:
O Posts
= Media Get Started Next Steps More Actions
) P
C:U Pages K Write your first blog post Manage widgets or menus
— Customize Your Site
@)) Comments _ <+ Add an About page E) Turn comments on or off
-
S — . or, change your theme completely &3 View your site = Learn more about getting started We | COme tO yOU r WOI’d PreSS
N ppearance
% . dashboard. Feel free to explore
) ugins
—
0 Users At a Glance ; Quick Draft aroun d |
O
5 Tools * 1 Post L. 1 Page Title
; Settings . 1 Comment
What's on your mind?
O © Collapse menu WordPress 4.4 running Twenty Fifteen theme.
)
c"f_j Akismet blocks spam from getting to your blog.
I There's nothing in your spam queue at the moment.
X
Activity
WordPress News
Recently Published
Oct 6th 201 5' 5:33 pm Hello world! WOI’dPFESS 4.4 "C|Iff0rd" December 8, 2015
.
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& JUPITER *

Avad

LOVED BY 180,000+

#1 Best Selling
WooCommerce
heme Ever

Installing a

TAA AR

SEO

M Optimized awfm \SU;hm s 4‘:’3-:»« &'@MH

WordPress
Theme

R — E—

Choosing a reliable theme before even building your WordPress site is of paramount
importance. One of the implications you will face it you switch themes in the middle of
your site development is redesigning all your pages from scratch again.

In the next slide, we'll learn how to choose a great WordPress theme.
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Modern Web Design Trends

W Flat Design (@) Responsive Design
i Mix & Match Typography a Micro UX Eftects

\’ @ Compact Navigation Menu ;}‘ Parallax Web Design

&) Screen Estate Maximisation @ Rich Media Content
‘,‘\\ Infinite Scrolling

&* Minimalistic Design

4!';

was! Monochromatic Colours

W Full-Width Imagery

(@) Translucency & Transparency & Minimal Text

View full article at www.equinetacademy.com/latest-web-design-trends/

S
)

N
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How to Choose a Reliable WordPress Theme

Consistent Theme Updates:

A theme that's outdated and incompatible to
the latest WordPress version risks security
vulnerabilities and display-rendering flaws.

Good Customer Support:

Sometimes even with web development
experience, solving theme issues can be
quicker with the help of the theme developer.

Well Documented:

A well documented theme can save you a
lot of time trying to figure out theme-
specific features and customisations.

Look for themes that have life-time theme
updates and customer support.

: :

Responsive Design:

Browser responsiveness is ever more
important as smartphone and tablet usage
overtake desktop usage.

Compatible With Mainstream Browsers:
't is iImportant to test the theme against
popular browsers such as Chrome, FireFox,
Safari, Internet Explorer, and Opera

)
-
O
C
I_
%
%
2
Al
=
=
qu
(@)
=
S
%
£

Features Availability & Customisability:

't is generally easier to customise the front end of your
website with a theme fully loaded with built-in design
features and a flexible internal design framework.

Choosing a theme thousands have already tried their
hands on instead of testing a newly developed theme
can save you from headaches and wasted time.

.:.
N
N

N
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) A DemoSite B 4+ New Howdy, demouser i

Dolly'll never go away Screen Options Help

@ Dashboard Dashboard

Home

i Welcome to WordPress! i
D e We've assembled some links to get you started:

0
GE) Media Get Started Next Steps More Actions Once you have purchased a
|£ Pages K Write your first blog post Manage widgets or menus prem lum theme (We wWill be usin g
N Comments 4+ Add an About page € Turn comments on or off the Genes's fl’ameWOl’k and Dlgltal
g R 1 COMpletely &3 View your site [ Learn more about getting started Pro Ch||d theme for th|S COUI’SG),
% S Customize you can now proceed to install it
o e Wiogets . QuickDraft - into WordPress.
Menus

; Tools T IM 1 Page Title
© Settings Background , . 1 . N&Vlgate tO Appearance =>
@)) ; What's on your mind?
- Collapse menu Editor g Twenty Fifteen theme. Themes
c:U Akismet blocks spam from getting to your blog.
-ICT) There’s nothing in your spam queue at the moment.
2

Activity

WordPress News
Recently Published

At Lol ANALE £12 e Llalle sasouledl WordPress 4.4 “Clifford” December 8, 2015
74a.alstarrental.com/wp-admin/themes.php

Qy
N

N
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http://shareasale.com/r.cfm?b=241369&u=1340495&m=28169&urllink=&afftrack=

Themes e Add New wy ., Search installed themes...

° wedp e
[ ]
> [ ]
® o JTwency Fifteen
pPr v e é
Twenty Sixteen xu ®
e Ll ° [ ]
[ ]
[ ]

[ ]
-
Come Sall Away with Me oz o
Dadrerd iy, we w s wae oo Dogpellieg, we e wroocac i ik e A IS
WAl Iovmurlomdinalds MO MAE v omi Lok v
Nw Tewrh riv ol tewe by cywiwreeseliwe ooy
Tos wavwie v A CLT LN R ST R R N
S E AT SRR L PSR TR TN N
e e twne by e oy dw Ao LR
il ardiimin i mimimmna mndiramy ) ° »
- b ~ [ ]
T P I P 25 The Myth of the Pier e
- . - ' r L)
I .
ol L AR R L szt ey fobks Xox Ukde o cbis g ok

griddnapheinrciraptertrepec iy 2izaeab

WA TIH NI RN et DR X IR T I O

slTalilis samil Twatiord smn WiriW¥ o ey il ™o

nasctl messnvtag s dograaldrv amiune
el od s bharsnnsnanarh anmn i

. 1. Click “Add New”

Active: Twenty Sixteen Customize Twenty Fifteen

D
-
O
C
I_
0
%,
=
Al
=
=
®
(@)
=
S
B
=

Qy
N

N
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@A DemoSite + New Howdy, demouser i}

Editor

A Plugins

BluLnisHor . . we @

sa Users

Boldly Go Green

Where no green has gone before zm—]

/ Tools

While the band’s playin’ Help
& Dashboard Add Theme
A Posts Teel, .
m Featured Popular Latest Favorites £+ Featuse Filter

07 Media Tre.
D | Pages A 3
E MORNING TIME LITE iy i’ i ®.e é ' iIIyria
= ® Comments R G e s ol .
C ~ .
— M Appearance Come Sail Away with Me = el
g)) Themes 2 -
O Customize _ :
al Widgets = _— ' oo TS : ' ' R ..,

S, ; ® LI . 1 1)

O vess R , | 1. Click “Upload Theme
O Header ™ Lorem ipsum Dolor
; Background Twenty Sixteen MorningTime Lite llyria
®
(@)
-
QV)
)
0p)
-

Settings

€ Collapse menu

BOLDLY
GO
GREEN

Qy
N

N
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) A DemoSite B 4+ New Howdy, demouser i}
While the band’s playin’ Help

#% Dashboard Add Themes R

» Posts

07 Media

¥ vimni1 ) . thamo i vd -1 ™| ~\/ ctall it w1y ~~inc it | re
If you have a theme in a .zip format, you may install it by uploading it here.

M Pages

® Comments

g | Choose file | NO)file chosen
X Appearance <

Themes

Customize

Widgets Featured Popular Latest Favorites £+ Feature Filter

i — ' 1. Click “Choose File”

Header

MORNING TIME LITE wr o — — | Hllyria

Background

Editor

————————— R ) Lorem ipsum dolor sit amet,
Come Sail Away with Me ancer - consectetur adipscing elit

A Plugins
@

sa Users

/ Tools

D
-
O
C
F__
0
%,
=
Al
=
=
®
(@)
=
S
B
=

Settings

) Collapse menu - .
v Twenty Sixteen MorningTime Lite llyria

Qy
N

N g

Equinet WordPress Website Creation Training Course
Academy 50




== v || (2] Downloads

4»

= digital-pro.zip

B genesis.zip
[ ]

Name

Kind

Size
Created
Modified
Last opened

P hhbhbbhbbbbbbbiid 1'

genesis.zip

ZIP archive

434 KB

Friday, 5 August, 2016 3:43 pm
Friday, 5 August, 2016 3:43 pm
Friday, 5 August, 2016 3:43 pm

D
-
O
C
I_
0
%,
=
Al
=
=
®
(@)
=
S
B
=

Twenty Sixteen

Format: | All Files

4r

| Cancel | [ Open

I v AR A Tl A e Ll b B Bl Ll o e L e Cn ) 8

Wl ovniandg mabn lm smvhygl ah w b

Bl mm e 2T ol o A 10300 w0 A e A
sunnwvssone s srwcomc ol s alwr s ol sxpe
B S L P N ST

Pluto

yo—

Today, Over a billion people live in slums. l
e That's 14% of the world's population,

Benevolent

3

N

Q3
N

.
Equinet
Academy
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-1, Select theme file in .zip format
o2, Click “Open”
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Add Themes erowse

If you have a theme in a .zip format, you may install it by uploading it he

[ Choose file JgeneSiS-Zip Install Nowv

Featured Popular Latest Favorites £+ Feature Filter Search 1. Click “Install Now

- | —

Pluto QOVOO*=0OO

Benevolent

v Already Installed

D
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=
Al
=
=
®
(@)
=
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Come Sall Away with Me zer

e oo on o Qoo Tumacilear oS L L S Sl N
iadread iy, W s i coop cugeilngg, we ws i oL Nt BB s —
AT B AR el
P Tl
¢ Wodlla 2o sl sl ML MAE v Lk i et e
A Teverh riv @ ombo ewerh ywiwreieliw e T Tl AR R
- —— - LR
M Teys nawie s Ao nsnnmrivd,cda v o alnly PRANL S A
oy - NIRRT TR L T b T N AR )
Jewan € drww e iwwo by aoa oy, dw o v oo SRR -
e calln anioimaa g mimin e o m Liramy
chiser

Welcome to Theme Demo Post

MBI RS A A 3
wim. o vnandy mab v ln smi gl ob 2 b TOda
L I T T L L R PSS R g e - i lhemideala Th
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Installing Theme from uploaded file: genesis.zip 1 Click “Activate’

Unpacking the package...

Installing the theme...

and activate the "Digital Pro child

.................... Repeat the previous steps to install
.............. theme”.

Theme installed successfully.

To find out more about what is a
child theme and its purpose, check
out this article.

Premium WordPress themes
usually come with a child theme. If
It doesn’t, you have to create your
own. To learn how to create a chila
theme, check out this guide.

D
-
O
C
I_
0
%,
=
Al
=
=
®
(@)
=
S
B
=

Alternatively, you may use the One-
Click Child Theme plugin to create
a child theme.

.
Qy
N

>
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http://www.wpbeginner.com/beginners-guide/wordpress-child-theme-pros-cons/
https://codex.wordpress.org/Child_Themes
https://wordpress.org/plugins/one-click-child-theme/

Y @ AlstarRental ® 0 - New Howdy, demouser

Help ¥

# Dashboard Themes e Add New Search installed themes...
@ Jetpack

Guneuin Frameaock R apncts - Pampleben -
T 1 W Twency Afteen
¢¢¢¢¢ o -~ Codmy s S & Nl

Q i i - "

3] Media Great Experiences Samole Post With Tesded Comments e . Once yOu have installed and
2piuUn s vy doonss aros sl sading Liano oy 1l A FHOERY °. IOV QLT — LIS 340 - = " ,_’ ~ "

. o A I D A A e 10 P MO et ‘e [ []

L Pages SON A N GOv MM UL wavarLy DM MY AN M e L A l | l |
FXREZIMAINDINENENIVYE L o W | V y |

)
RO - |
2 e A e e e W e g e M . .
Comments o £ T 50 A 2 s, T At 1 e P
S0 OO A0 TN D Pl MO MO AT 3T BN B0 WA 0N W O M Fazect Fean 2, et S Ol I See e O OWI | I | I I Ol I r
COWRY I Vo0 SV SNMAN MY DA 0 500 HOE ORI I MG NP (DL SN AEM D Sarxis Sl 805 ccabed Comen ol artAc e
5 e e I el L
Ry n Ml 1 b 4 vl b o mrad -

T o o g of s VA s e o v i b o 4 i A e el 8 3 LIS v Azt edire: Mok o O WE4Le ot xr g ok

G GeneS|S GETPELACCESS VAL REMSLITTIR 0 A AD PR, G A [ O GOV ) Vs Vi A N 'y AR M 30 M Sy Bad R0 g Mhient e e #risnaphetisercAapitertr epecxy 2izapeats —
W R NN O AN W W T e Borss And V. haayt Ow s SN TR I O W e T X T D s I — .

Oge o ordtyvreiram o swyin 0 WAt WEalitiis wdndl Taatho amm o in i o' baam a6 dvin
Tl o mmogh AV AN oy o MM R ap A o o et e Ao Al N e Aarn il merarday J.gwalev a miuse
'

T T T L N TIPS AT

Next, we will be customising your

Themes

Customize Slte SettlﬂgS

Widgets

Menus Twenty Sixteen

e Come Sall Away with Me . NIRRT St ] i * Clle Oﬂ “Settlngs,’

Editor

A Plugins

D
-
O
C
I_
0
%,
=
Al
=
=
®
(@)
=
S
B
=

sa Users

/V 190 . .?':‘.lo.|‘.P|:f‘-.1.-’-.:;|.s; i .u. WA s - . Add New Theme

Settings

Twenty Fourteen Twenty Sixteen

€ Collapse menu

-...
N

N
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# VenueSquare ¥ 0 < New Theme Options Howdy, demouser [

Help
Forlenls General Settings
Posts
Site Title Venue Square
Media
Pages Tagline Training room rental
Comments In a few words, explain what this site is about.
Portfolio Items
2 WordPress Address (URL) http://venuesquare.com
Enfold Child
Appearance Site Address (URL) http://venuesquare.com
Plugins Enter the address here if you want your site home page to be different from your WordPress installation directory.
Users
Email Address equinetsg@gmail.com
Tools
This address is used for admin purposes, like new user notification.
Settings
General Membership Anyone can register
Writing
Reading New User Default Role Subscriber :
Discussion
Media Timezone UTC+0 : UTC time is 2016-62-18 03:00:53
Permalinks N .
Choose a city in the same timezone as you.
LayerSlider WP
Date Format ® Februarv 18. 2016
In your Settings, you can configure settings such as:
1. Site title, admin email address.
2. Assign a home page and blog roll, and more.
quinet WordPress Website Creation Training Course
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5 A VenueSquare B

& Dashboard

# Posts

07 Media

M Pages

% Comments
A Portfolio Items

£¥ Enfold Child

> Appearance
A Plugins

sa Users

/ Tools

Settings

General
Writing
Reading
Discussion
Media

Permalinks

LayerSlider WP

<4 New Theme Options

General Settings

Site Title

Tagline

WordPress Address (URL)

Site Address (URL)

Email Address

Membership
New User Default Role

Timezone

Date Format

Howdy, demouser [

.o°.. Help

(T 1)
Venue Square P

Training room rental S |
inofewwords: exploin Whst IhE Site S obolE = = s o e s e @ e a G daa e b aa bd aa dd e il
( \ ........
http://venuesquare.com 4 ......
http://venuesquare.com B

Enter the address here if you want your site home page to be different from your WordPress installation directory.

equinetsg@gmail.com «{

This address is used for admin purposes, like new user notification.

Anyone can register §

Subscriber =

UTC time is 2016-62-18 63:60:53 :

UTC+0 ¢

Choose a city in the same timezone as you.

® Februarv 18. 2016

-...
N

gl
Equinet
Academy
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Your Site Title and Tagline might be
picked up by search engines and

" may show up on their search

results pages.

You may choose to set your
Uniform Resource Locator (URL) to

begin with either “http://www.” or

“http://“. To set your URL to e.qg.
“http://www.”, add www. to both the
WordPress Address URL and Site
Address URL to ensure it Is
working properly.

The email address you specity here

... will be used for admin purposes,

such as notification of new user
registrations.

To allow anyone to register as a
user, check this box. However we
do not recommend checking this
option unless necessary due to the
amount of spam registrations you
will receive.
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# VenueSquare B 4 New Theme Options Howdy, demouser [

| Wadiiuvudiu

New User Default Role Subscriber H
Posts
Media Timezone (UTC+0 = urc t/Ae S 2016-02-18 63:24:00
Pages Choose a city in the same timezone as you.
Comments
: Date Format ® February 18, 2016
Portfolio Items .
2016-02-18 - 1. Set your date and time
Enfoldchild 02/18/2016 O................O........O.. . h
settings here.
Appearance 18/02/2016
Plugins Custom: Fj, Y February 18, 2016
.. 2. Click Save.
Users Bl
Time Format ® 324 am SO B
Tools S
24 o G . 1 "L 1)
, el Next, click on “Writing”.
Settings 03:24 Ll
General Custom: gia  3:24am o %
Writing Documentation on date and time formatting. 0 e o3
Reading \. J S )
Discussion Week Starts On Monday = S s s
Media R P
Permalinks Site Language English (United States) 4

LayerSlider WP

© Collapse menu

N g
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WY @A VenueSquare B < New Theme Options Howdy, demouser-

200 AT . Here, you can change your default
s blogpost category and default blog
£ fan Default Post Category (iUncategorized 3? <« pOSt format'
07 Media ’
LI s . .
2 Cages . T il | f you wish to post to WordPress via
ommen . . .
A Portfolio Items posvierit. . emall’ YOU can do SO.by Settlﬂg up
.ﬁ. Enfold Child To post to WordPress by email you must set up a secret email account with POP3 access. Any mail received at this address will be posted, SO Lt'sagbéd’ic;e:a ;o keep this your mall Server detalls here
address very secret. Here are three random strings you could use: wnRskLcL , VX7jcg99 , 7taFwféz . .= ""
Coozeemrce REEEEEG GGG : : :
D Mail Server nail.example.con . e If you wish to automghcally notity
... popular update services such as
ea Users : :
o Login Name login@example.com pingomatic that you have updated
. ools .
, your blog, you may enter multiple
Settings Password password . .
. GGG T services URLs in the box below.
Writing Default Mail Category neasgorized S DOlng SO Can increase traﬁc'C to
e yOUI’ Slte
Discussion UpdateSérviees . e
NN e
When you publish a new post, WordPress automatically notifies the following site update services. For more about this, see Update Services on the Codex. Separate multiple I (¢ " & "
P i e . i ! P e Next, click on “Reading” settings.
LayerSlider WP http://rpc.pingomatic.com/ 4’
=
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&Y @A Venue Square

® Dashboard

Posts

Media

Pages
Comments
Portfolio Items

Enfold Child

Appearance
v Plugins
Users

Tools

Settings

General
Writing
Reading
Discussion
Media

Permalinks

LayerSlider WP

7z <4 New Theme Options

Reading Settings

Front page displays

Blog pages show at most

Syndication feeds show the
most recent

For each article in a feed,
show

Search Engine Visibility

e Your latest posts

A static page (select below)

Front page:

Posts page:

\_

10 posts

10 items

e Full text

Summary

Discourage search engines from indexing this site <

It is up to search engines to honor this request.

Howdy, demouser [
Help

gl
Equinet
Academy

By default, WordPress displays
your latest posts on your
homepage. To change it to display
a static page, click on “A static
page” and select "Home" page to
assign it to your homepage.
Similarly, assign a page to display
all your blog posts.

Select this option only if you do not
want search engines to index your

site. Warning: Doing so can reduce
your site traffic signiticantly.

Next, click on “Discussion’
settings.
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# VenueSquare B 4 New Theme Options Howdy, demouser [

Help

DA oM Discussion Settings
Posts

Default article settings v'| Attempt to notify any blogs linked to from the article
Media v| Allow link notifications from other blogs (pingbacks and trackbacks) on new articles
Pages v Allow people to post comments on new articles
Comments (These settings may be overridden for individual articles.)
Portfolio Items '

Other comment settings v| Comment author must fill out name and email H ere ) yOU can cu Stom ISE yOU r
Enfold Child ; : :

Users must be registered and logged in to comment d ISCUSSION Set“ N g S SUC h asS
> Appearance Automatically close comments on articles older than 14 days comme nt auth or req U | reme ntS :
K¢ Plugins v| Enable threaded (nested) comments 5 4 levels deep comment email notification

o :
- s Break comments into pages with 50 top level comments per page and the last § page displayed by default Set“ N g S, an d more.
# Tools

Comments should be displayed with the older § comments at the top of each page
Settings

S Email me whenever v'| Anyone posts a comment

Writing : .
v| A comment is held for moderation

Reading
Discussion
e Before a comment appears Comment must be manually approved

eaila

P v| Comment author must have a previously approved comment

LayerSlider WP Comment Moderation Hold a comment in the queue if it contains 2 or more links. (A common characteristic of comment spam is a large

gl
Equinet
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# VenueSquare B 4 New Theme Options Howdy, demouser [

Avatars
Dashboard
An avatar is an image that follows you from weblog to weblog appearing beside your name when you comment on avatar enabled sites. Here you can enable the display of
Posts avatars for people who comment on your site.
Media
Avatar Display v'| Show Avatars
Pages
Comments Maximum Rating * G — Suitable for all audiences
Portfolio Items PG — Possibly offensive, usually for audiences 13 and above .
Scrolling further down, you may
Enfold Child R — Intended for adult audiences above 17
choose the default avatar to show
X — Even more mature than above
# Appearance for a comment author.
A Plugins Default Avatar For users without a custom avatar of their own, you can either display a generic logo or a generated one based on their email
address.

b . 1 . 1) .
- * Mystery Person NeXt, C||Ck on Med|a Settlﬂgs
# Tools
Settings Blank
General E Gravatar Logo
ertlng L
Reading .'::l- Identicon (Generated)

Lo % Wavatar (Generated)

Media
Permalinks @ Monster|D (Generated)

LayerSlider WP Retro (Generated)

gl
Equinet
Academy 6l
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Y @A Venue Square

® Dashboard

Posts

Media

Pages
Comments
Portfolio Items

Enfold Child

Appearance
v Plugins
Users
Tools
Settings
General
Writing
Reading
Discussion

Media

Permalinks

LayerSlider WP

Media Settings

Image sizes

The sizes listed below determine the maximum dimensions in pixels to use when adding an image to the Media Library.

Thumbnail size

Medium size

Large size

Uploading Files

<4 New Theme Options

Width 80

Max Width 300

Max Width 1030

Height 80
v| Crop thumbnail to exact dimensions (normally thumbnails are proportional)

Max Height 300

Max Height 1030

v'| Organize my uploads into month- and year-based folders

Howdy, demouser

Help

gl
Equinet
Academy
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At Media Settings, you can define
your auto-generated image sizes
and file organisation settings.

Next, click on "Permalink” settings.
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# VenueSquare B 4 New Theme Options Howdy, demouser B

, Help
| DRERCHD Permalink Settings
Posts WordPress offers you the ability to create a custom URL structure for your permalinks and archives. Custom URL structures can improve the aesthetics, usability, and forward-
compatibility of your links. A number of tags are available, and here are some examples to get you started. . . .
Media . . Your Permalink settings gives you
ommon settings . :
Pages the option of creating a custom
Comments Plain TR T e P URL structure for your posts,
Portfolio Items :
pages, and archives.
Enfold Child * Day and name http://venuesquare.com/2016/02/18/sample-post/
Appearance |
Ppe Month and name http://venuesquare.com/2016/02/sample-post/ H: IS recom me n d ed tO Set you r

Plugins permalink settings to "Post Name”
Users for better search engine

i ,I\ju.m.eric http://venuesquare.com/archives/123 N B s oo

Tools

R R R IR N e ® © .'.'.0.0..0.0.0.‘.°.'..... G frlendllneSS-
Settings (Post name) 4' ss  a 'http://venuesquare.com/sample-post/ e e SUm S
General 1B . (@ 3
Writing Custom Structure http://venuesquare.com /Xyeark/%monthnumk%/%day%/%postnamek/ NeXta Cl le On Users .
Reading
Discussion Optlonal
Media If you like, you may enter custom structures for your category and tag URLs here. For example, using topics as your category base would make your category links like

Beco http://venuesquare.com/topics/uncategorized/ . If you leave these blank the defaults will be used.

LayerSlider WP Category base

N
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\‘:‘/ # VenueSquare B 4+ New Theme Options Howdy, demouser [

Screen Options Help
Dashboard Users el s v
Posts All (1) | Administrator (1 L b Search Users
Media Bulk Actions 3§  Apply Change role to... ¥ .C.hfange oo 1 item
Pages Username Name e “e., . Email Role Posts
Comments L3 demouser « .e.q:Jihets.g@gmail.com Administrator 1

Portfolio Items SRR

esrrereeeeeeeeennl, L, L, TO €T AN existing user, click on the

Enfold Child e Name Email ... Role Posts

username.

Bulk Actions 3§  Apply Changeroleto... ¥ Change NS 1 item

> Appearance

#

A’ Plugins

"+-..., loadd anew user, click "Add
New”. Let’s click on that.

o Users

All Users
Add New

Your Profile

/ Tools

Settings

LayerSlider WP

© Collapse menu

Thank you for creating with WordPress. Version 4.4.2

-
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# VenueSquare ¥ 0 < New Theme Options Howdy, demouser [

Help
& Deshboard Add New User
Posts Create a brand new user and add them to this site.
Media ( )
Username (required)
Pages
Comments & :
Email (required)
Portfolio Items Sl cecocoe -
oooooooooooooooooo.o"'°.... 1. Enteruserdetalls.
Enfold Child First Name o seen et 2ol &
Appearance - ...+ 2. Select user role.
Plugins ......-
: R ? . (o 1)
sl Website ...-+3. Click “Add New User
All Users ....o°. .....o'.
Add New Password \Showpassword > ......,.°° .......,....
Your Profile ...0‘ ..,.0'
J Tools Send User Notification v'| Send the new user an email about tpeir.a'cCohr.wt. Gy ey :
5l Settings A
Role v Subscriber A
: : Contribugare * °
L I WP P
ayerSlider 1. aathér
© Collapse menu m > i : Editor
Administrator
.
Equinet WordPress Website Creation Training Course

Academy 65



&) A VenueSquare ¥ 4+ New Theme Options Howdy, demouser [

a Users s Screen Options Help
* Posts New user created. Edit user
] Media ——— A new user has been created. To
B Pages e U ek add a profile picture, navigate over
B Comnants Bulk Actions 3  Apply Changeroleto.. ¥ Change 2 items
. e e to Gravatar and create a new
# Portfolio ltems Username Name mal
i g . i T i 1 account over there. In order for the
profile picture to show, the email
»N Appearance Newuser Venue Square alstarrental@gmail.com Author 0 addreSS at Gravatar haS tO be
K Plugins —/ similar as the email address
& Users Username Name Email Role Posts SpeCIerd Iﬂ the WOI’d PI’GSS user
All Users Bulk Actions 3§  Apply Changeroleto... ¥ Change 2 items proflle
Add New
Your Profile
# Tools
Settings
LayerSlider WP
© Collapse menu
Thank you for creating with WordPress. Version 4.4.2
S
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https://en.gravatar.com/

' Venue Square <= New Theme Options Howdy, demouser Bl

Dashboard p|ugins

Posts All (2) | Inactive (2)

Screen Options Help

Search Installed Plugins

07 Media Bulk Actions §  Apply 2 items
Pages | Plugin Description

Comments Akismet Used by millions, Akismet is quite possibly the best way in the world to protect your blog from spam. It keeps your site protected even while
Activate Edit Delete You sleep. To get started: 1) Click the "Activate" link to the left of this description, 2) Sign up for an Akismet plan to get an APl key, and 3) Go to
your Akismet configuration page, and save your API key.

Portfolio Items

¥ Enfold Child Version 3.1.7 | By Automattic | View details
Appearance | Hello Dolly This is not just a plugin, it symbolizes the hope and enthusiasm of an entire generation summed up in two words sung most famously by Louis
Activate Edit Delete Armstrong: Hello, Dolly. When activated you will randomly see a lyric from Hello, Dolly in the upper right of your admin screen on every page.
k¢ Plugins
- € Version 1.6 | By Matt Mullenweg | View details
Installed Plugins
Add New Plugin Description
Editor Bulk Actions % = Apply 2 items
Users
Tools
Settings
LayerSlider WP
Thank you for creating with WordPress. Version 4.4.2

Plugins help to extend the functionality of your site.

1. Navigate to Plugins
2. Click “Add New”
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Help ¥

Add Plugins upload Plugin There are a few ways to install a
plugin:
Search Results Featured Popular  Recommended Favorites Keyword % 'I tinymce advancedl J _ |n8ta”ing |J[ direCtly from the
. 3 WordPress Plugin Directory
218 items  « < *1 of8) > » . .
g - Uploading the plugin through
TinyMCE Advanced Install Now R3DF Beaver Builder irstall Now the WordPress dashboard
Extends and enhances TinyMCE, More Details T,myMCE Advanced Icon Mo.ré-Details - J pload | ﬂg the p Ug | N th rOug h
the WordPress Visual Editor. Fix " :i |e TranSfer Pro.-ocol (FTP)
Fixes font icon's not showing in " . . -
ki TinyMCE with TinyMCE Advanced such as FileZilla.
. and Beaver Builder. .
(208) Last Updated: 4 days ago B;’.%D.F. We W||| iﬂStall the plugln “Tiﬂy MCE
1+ Million Active Installs v Compatible with your version of WordPress . .. Advan Ced ” .
1) "*._ Last Updated: 5 months ago )
100+ Active Installs Untested with your version of WordPress B o o
: . 1. Enter "tinymce advanced” in the
search box and hit enter on your
TinyMCE Annotate Install Now TinyMCE Custom Styles Instalt Now keyboard.
Create annotations in your More Details Improve TinyMCE visual editor by More Detai]s. * 4
content. adding custom editor stylesheets ‘e, _ . .
Y A= and a configurable styles -.2. Next, click install, and activate.
s
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https://filezilla-project.org/

All (4) | Active (2) | Inactive (2) Search installed plugins...

Bulk Actions §  Apply 4

Plugin Description
Akismet Used by millions, Akismet is quite possibly the best way in the world to protect your blog from spam. It keeps your site prote:
Activate Edit Delete even while you sleep. To get started: 1) Click the "Activate" link to the left of this description, 2) Sign up for an Akismet plan tc

an APl key, and 3) Go to your Akismet configuration page, and save your API key.

Version 3.2 | By Automattic | View details y -

That's it! Your plugin has been

Hello Dolly This is not just a plugin, it symbolizes the hope and enthusiasm of an entire generation summed up in two words sung most mStal |ed SUCC@SSfU | |y
Activate Edit Delete famously by Louis Armstrong: Hello, Dolly. When activated you will randomly see a lyric from Hello, Dolly in the upper right of

admin screen on every page.

Version 1.6 | By Matt Mullenweg | View details et R NaVigate (0 Se’[’[ings =>
TinyMCE Advanced.

Jetpack by WordPress.com  Bring the power of the WordPress.com cloud to your self-hosted WordP;e.ss -J-etpack enables you to connect your blog to a
Jetpack Deactivate Edit WordPress.com account to use the powerful features no.rmaliy'only available to WordPress.com users.

Version 4.4.2 | By Automattlc J View detsils”

TinyMCE Advanced Lee*°” 'Enables advanced features and plugins in TinyMCE, the visual editor in WordPress.
(Settings )ﬁét'vate Edit Version 4.4.3 | By Andrew Ozz | View details

Plugin Description

N
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Comments
- Enfold Child

Portfolio Items

el WooCommerce

" Products

Appearance
¢ Plugins 3

Users

Tools

Visual Composer

Settings

General
Writing
Reading
Discussion
Media
Permalinks

TinyMCE Advanced

¢{> Shortcodes

v'| Enable the editor menu.

Fle+« Edt+ Insert+ View+~ FoOormat+. Table+ TooOls

-[B| I ¢« = &

Font Family «+ Font Sizes

hili
Q
oS
H
J
R
4

Paragraph v

wme i DR OO0 O=Z © A @

Drag buttons from the unused buttons beiow and drop them in the toolbars above, or drag the buttons in the toolbars to rearrange them.

Unused Buttons

U Underline Formats . v| | ¥ Cut [y Copy K Paste X, Subscript

X° Superscript — Horizontal line [ad] Insert/edit image #= Print ﬂ Anchor ﬂ Find and replace
9T Show blocks 9T Show invisible char..., | <> Source code <> Code O Insert date/time B Insert/edit video

[ Left to right 9T« Right to left A Background color M Page break

.+, Nonbreaking space

Options

v List Style Options

Enable more list options: upper or lower case letters for ordered lists, disk or square for unordered lists, etc.

Context Menu

Replace the browser context (right-click) menu.

Qy
N

)
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1. Drag the fields from the
Unused Buttons sections to
the Visual Editor above. This
will enable advanced
formatting options such as
Font Family and Font sizes.
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My Blog New

Dashboard PageS

Jetpack All (0)

Posts

Media | Title
Il Pages No pages found.
All Pages | Title

Add New

Comments

Genesis

Appearance

Adding Site

Plugins
Users

Content

Tools

Settings

One of the first things you do after installing your theme is creating your site pages and
organising the structure of your site.

1. Navigate to "Pages”
2. Click “Add New”

) WordPress Website Creation Training Course




Y @A VenueSquare B “+ New Howdy, demouser .
Screen Options Help
#® Dashboard Add New page
2 Posts | " Since we will be simulating a
07 Media training rooms rental niche, add the
Save Draft Preview

M Pages

All Pages

07 Add Media

Word count: 0

Visual

Text

¥ Status: Draft Edit

@ Visibility: Public Edit

Need help? Use the Help tab in the upper
right of your screen.

Featured Image A

Set featured image

Qy
N

>

following pages to your site:
® Home

c
O Add New B I e = = ¢ = = =P R E E poe
E " - _ ﬁﬂ Publish immediately Edit ’A” Rooms
Comments ~ .
8 S R I\/Ie.et.mg Room Rental
D Appearance ‘Tralﬂlﬂg ROOm Reﬂta|
&5 S TR R ._ e Seminar Room Rental
O) Users — ® Reﬂta| RateS
C Tools .
= - e * Booking Form
g Order ¢ Blog
. e About Us

e Contact Us

Equinet
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% @ VenueSquare W 4+ New Howdy, demouser [

Screen Options Help
#% Dashboard Add New Page
//\
A Posts 1\H0me> 9 ..... ] Publish
q] Media s e ¥ T ee. X e e BRI :
RSN S Save Draft Preview
I_. Pages R L R ® o
. G e Status: Draft Edit
S All Pages %1 Add Media Visusl® * Fext, , . . !
> *Vistbitity: Pubic Edi
- . B I = = ¢ — ==L RREB = Rl T
+ il Publish immediately Edit BN | . : :
B » cornrerts ---1. Type in the title of the page
Move to Trash ‘ !
O J¥ Appearance o @ (eg Home )
) PP - || .
) P 2 ® e
. — A Plugins X O
Page Attributes a ° . . ( . 3
P L g -2. Click “Publish
dsd
O) Parent
E /~ Tools
e (no parent) %
@) Settings E
< € Collapse menu Orcer
0

Need help? Use the Help tab in the upper
right of your screen.

Word count: 0 Draft saved at 4:13:55 pm.
Featured Image
Set featured image
5
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W MyBlog 10+ New ViewPege s Once the page is published, you
Screen Options ¥ elp v " Fi " i
= Dasiboard EditPage adanew e acceldll| IAATERRY will see the green notification icon
................................... Above

@ Jetpack

[ Page published. View page }

# Posts

The permalink is also auto

07 Media Home Publish A .
| — _ generated and can be edited by
l! Pages Permallnk@ttp://demoweb5|te56.5|te/home/ Edit ’ ooooooooooooooooooooooooooooooooooooooooooooooooo 'Pr'efriéw'Ch'ar?g'es ooooooo . . ) .
- o clicking on the "Edit” button.
GC) All Pages 07 Add Media —— ¥ Status: Published Edit
Add New
+— ®°° e 0 e 0000 0, P @ Visibility: Public Edit . .
= - Filg ¥ " RV *héetes View v - Formatew Tablpy, Tooly . hyd 12 20 0 ot Continue adding the rest of the
aragra v =y Dy = = = AR N0 Tttt DI ull, Ruplished on: Dec 12, : : :
® il = e S & . H e L following pages of your site and
GO Genesis Font Family ¥ FontSizes v ¢ = i QO = A v v © : : _
pe R publishing them:
@) > Appearance ’A” ROOmS
8 Sl Page Attributes . * Meeting Room Rental
= Lees remplate -Tram.mg Room Rental
<C ezt e ——. e Seminar Room Rental
ik order e Rental Rates
Collapse menu o PY Booklng Form
Need help? Use the Help tab above the ¢ B|Og
screen title. .About US
e Contact Us
s
Equinet WordPress Website Creation Training Course

Academy 74



)
C
O

)
C
@)

O
O

=

)
@)

=

_cj

O

<

W) @ MyBlog ¥

2% Dashboard

) Jetpack

# Posts
7 Media

B Pages

All Pages
Add New

Comments

[l
© Genesis

Appearance
v Plugins

Users

Tools

Settings

Collapse menu

+ New View Page
Edit Page Add New

Meeting Room Rental

Permalink: http://demowebsite56.site/meeting-room-rental/ Edit

QJ Add Media Visual Text

Table ¥ Tools

B I ¢ =v v == =2 8 b

FontSizes v £ = |l ¢ Q = A v

File v Editv Insertv View v Format v

Paragraph v

Font Family v

Word count: 0 Last edited by demouser on December 12, 2016 at 2:58 am

Thama CEN Qattinme

Screen Options ¥

Publish

Howdy, demouser i}
Help ¥

Preview Changes

9 Status: Published Edit

@ Visibility: Public Edit

i1 Published on: Dec 12, 2016 @ 02:58

Edit
Move to Trash

Page Attributes

Navigate to the page "Meeting
Room Rental”.

. To create a subpage URL

Parent

(no parent)

_..-havigation structure, under "Page
Attributes”, select Parent.

Template

Default Template ¥

Order

0

Need help? Use the Help tab above the

screen title.

Qy
N

—
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W) @ MyBlog B 4+ New View Page Howdy, demouser i

Screen Options ¥ Help ¥
# Dashboard Edit Page AddNew
Q) Jetpack . _
Meeting Room Rental Publish .
A Posts Permalink: http://demowebsite56.site/meeting-room-rental/ Edit Preview Changes
% Media P . 9 Status: Published Edit
L. Pages 2 Add Media Visual Text
— . . . @® Visibility: Public Edit
D File v Editv Insertv Viewv Formatv Tablev Tools v
All Pages O . .
— — — = = = 5 W x_» 11l Published on: Dec 12, 2016 @ 02:58
Paragraph v 6 = v = v = = = ¢ 3 b
% Add New o B I o a\ Edit
FontFamily v FontSizes v <€ 3 | ¢ Q = Av Hr O . T 39 :
B » Comments e o Trach " upasie PRRR ‘Select "All Rooms”™. and click
o f ))
9 " “Update”.
-CB Genesis of
Page Attributes A b
@) Appearance o
E ' Parent L
1@ Plugins o
@) v (no parent) .
< Users About Us o
All Rooms )b
Tools
Settinas Booking Form
9 Contact Us
Collapse menu Home

Rental Rates
Seminar Room Rental
Training Room Rental ) above the

Word count: 0 Last edited by demouser on December 12, 2016 at 2:58 am screen title.
-3
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Screen vptons v Help v

Edit Page = Add New

| Page updated. View page '
Meeting Room Rental Publish A

Preview Changes

PermalinkGttg:[[demowebsiteSG.site[alI-rooms[meeting-room-rental[ }d'@

9 Status: Published Edit

o @7 Add Media Visual « Text,
- ; . : " * @ .\igibility: Public Edit

File v Editv | tv V v F tv Tablewv Tools v *e ., : :
Q e I nser lew orma able ools . . ... . NO’[ICG the Change N URL
C Paragraph v B I 6 = v v = =2 = 2 R O ¢ «» [ Published on: Dec iZ, 2016 @ 02:58 T -
8 e Rt el structure, with “all-rooms” in front of

Font Family ¥ FontSi v £ B B = A v v L : )
- il B Rl R - O e B T T meeting-room-rental”.
=

Next, navigate to “Pages’
CCD Page Attributes A g g
O
_O Parent
< All Rooms v
Template

Default Template %

Order
0
_
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C
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)
C
@)

O
O

=

)
@)

=

_G

O

<

%Y @A VenueSquare ¥

#% Dashboard

# Posts
07 Media
M Pages

All Pages
Add New

¥ Comments

»¥ Appearance
A’ Plugins
4

aa Users

/ Tools

Settings
) Collapse menu

=+ New

Pages Add New

All (11) | Published (11)

Bulk Actions 3  Apply All dates

Title

About Us

All Rooms

P T
Contact Us

Home

Meeting Room Rental

Rental Rates

Sample Page

s  Filter

Howdy, demouser [

Screen Options Help

(

Search Pages)

Author

demouser

demouser

demouser

demouser

demouser

demouser

demouser

v 11 items
& Date* ,

S Published ° » :
1 min ago

— Published
2 mins ago

— Published
1 min ago

— Published
1 min ago

— Published
1 min ago

A Published ° ® * ¢ . L .

17 mins ago

— Published
2 mins ago

— Published
1 min ago

— Published

Qy
N

N

Equinet
Academy

/8

Upon clic
will be ab

KIng on “All Pages”, you
e to see all the pages

you have |ust created.

Should you have any trouble
finding a particular page, use the

search pages function.

Next, we are going to place your
pages up on your main navigation

menu.

"* Navigate to Appearance => Menus
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W @ VenueSquare B 4+ New Howdy, demouser K

Screen Options Help
&b Dashboard Menus Manage in Customizer
A Posts Edit Menus
Q7 Media
|® Pages Edit your menu below, or create a new menu.

¥, Somments We will be creating a main
IS s Pages Menu Name Main Navi .., . ... naV|gatlon menu.

S g [ ]
Themes Give your menu a name above, then click Create Menu. tteee., . ..
= J ® o ® o o o

Most Recent

Customize

. ... 1. Start by entering a title for your

About Us m e n U .
Menus

Header H s .,

. 2 Click “Create Menu’.

Seminar Room Rental

Background

Editor

)
C
O

)
C
@)

O
O

=

)
@)

=

_G

O

<

Iraining Room Renta

A’ Plugins

Meeting Room Renta

sa Users

/ Tools

Settings Posts

Custom Links

Categories

Qy
N

N
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C
@)

O
O

=

)
@)

=

_G

O

<

~

W @A Venue Square

#% Dashboard

A Posts
07 Media
M Pages

® Comments

X Appearance

Themes
Customize
Widgets
Menus
Header
Background
Editor

A Plugins
sa Users
/ Tools

Settings

ar AT O YIS
@ \L'!l(&;),,i 1IN

== New

Edit Menus Manage Locations

Edit your menu below, or create a new menu.

Pages

Most Recent View All Search

Contact Us

About Us

Blog

Booking Form

Rental Rates

Seminar Room Rental

Training Room Rental

aSEANEANBANEANEANEASEAS

Meeting Room Renta) o « * ° ¥

A....

Select All Add to Menu <

Posts v

Custom Links —,.-

Categories v

Thank you for creating with WordPress.

Howdy, demouser [

Menu Name Main Navi

Menu Structure

Add menu items from the column on the left.

Menu Settings

Automatically add ngw top—lév’el‘p?sges to this menu

. o o* P Primary Menu

Auto add pages

Theme locations

Social Links Menu

Delete Menu

Version 4.4.2

...- 1. Select the pages you wish to
add to your main navigation menul.

oot 2. Click “Add to Menu”

Qy
N

N
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W @ VenueSquare B 4+ New Howdy, demouser B
# Dashboard Pages = Menu Name Main Navi
A Posts Most Recent View All Search Menu Structure
07 Media Drag each item into the order you prefer. Click the arrow on the right of the item to reveal additional configuration
5 Contact Us options.
@ Pages About US <. ® 6 6 6 ¢ o o & ¢ o oo o o A
Blog 50 S . :

E Y S Booking Form Rhi S : Drag aﬂd drOp yOur meﬂu ItemS Iﬂ
LONEN > Appearance Rental Rates AbautUs e order by left clicking on the menu
- Seminar Room Rental . . ,

NN T R A : item, holding on to your left mouse

SR o Meeting Room Renta B s L B button, and dragging the element
O Wid : |

gets . .

R ... asncio e bt Booking Form Poge v | - to your desired spot (e.g. “Home”
OV Bl eocer i : first, “All Rooms” second, and so
- L / Rental Rates Page v | _ On)

— ackgroun .

O Editor Custom Links v . '

O Seminar Room Rental Page v |
< A’ Plugins Categories .

. U Training Room Rental Page v .
an USErs .
/~ Tools Meeting Room Rental Page v E
Settings .
8 All Rooms Page v | °

( Home ) O A0S COS O SO0 O OO /O COS OO ha.gé [ ] 1’ >.

l .
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C
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C
@)

O
O

=

)
@)

=

_G

O

<

¢

#% Dashboard

W @ Venue Square

=+ New

Pages

Menu Name Main Navi

Howdy, demouser B

A Posts Most Recent  View All Search Menu Structure
07 Media Drag each item into the order you prefer. Click the arrow on the right of the item to reveal additional configuration
5 Contact Us options.
M Pages About Us
¥ Comments Bog Home Page v
Booking Form
» Appearance Rental Rates AR Page
Seminar Room Rental
Themes Training Room Rental >
, Meeting Room Rental Page ceceereeene

Customize Meeting Room Rental 8 :
Widgets

Select All Add to Menu A S Page v e cecco o
Menus
Header

Posts Training Room Rental Page v *°®°*°*°*°csee >
Background

: Custom Links
Editor Rental Rates Page v
A Plugins Categories
@ Booking Form Page v
aa Users
/ Tools Blog Page v
Settings
About Us Page v
€) Collapse menu
Contact Us Page v
N
Equinet

Academy

In order to create drop down

menus items (secondary menu
items), drag the menu items one

notch to the right.
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Howdy, demouser i

W @A AlstarRental ¥ 4+ New

2% Dashboard Seminar Rooms

el Meeting Rooms sub item Page v
@ Jetpack
select Al feptbichinn il Seminar Rooms sub item Page v

# Posts

@1 Media e e e B In order for the main navigation

M Pages CasEmLnks e . menu to be reflected on the front
b Categories end of your website, you need to
% @ Genesis st ol i set its location.
BN Blog Page v
CGJJ :hem:eaa . Abouws T Thel exgct Iocationlof the main
f/:) Cotoie navigation menu differs from theme
S widgets Contact Us Page v to theme, but you should select
- e “[theme name] Main Menu” or
2 Editor MenusSettings ettt sqmevvhere along those lines, and

Z e Auto add pages Automatically add newtop-level.pe:g.es: tothismenws +** """ click “Save Menu”.

5 Theme locations HeaderMenu « **° " " Lo

Footer Menu

/ Tools
Settings

e
Q) Collapse menu

Delete Menu

Qy
N

8
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O

=
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=
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O

<

W A ’enue Square

#% Dashboard

A Posts

07 Media

Pages

® Comments
A Portfolio Items

¥+ Enfold Child

X Appearance

Themes
Customize
Widgets
Menus

Editor

A¢ Plugins
aa Users
/ Tools

Settings

(=] LayerSlider WP

P s | PO
@ LOHNapse menu
!

&2 4 New Theme Options

MET}L,IS Manage in Customizer

|(Main Navi has been upZia'tédq . .)

Edit Menus Manage Locations

Edit your menu below, or create a new menu.

Pages

Most Recent View All Search

Contact Us

About Us

Blog

Booking Form

Rental Rates

Seminar Room Rental
Training Room Rental

Meeting Room Rental

Select All Add to Menu

Posts

Portfolio Items v

Howdy, demouser B

Qy
N

—
Equinet
Academy

Screen Options Help
After clicking “Save Menu”, you
; should see the green naotification
alert "Main Navi has been
Menu Name Main Navi ....".0., m Ugdated .
venu Structure Let’s visit the front end of your site
Drag each item into the order you prefer. Click the arrow on the right of the item to reveal additional configuration S, . . y yy
e o ) ) *+-.. by clicking on the “Home” icon
located at the top left hand corner
ome Page T |41 v
: : of your dashboard.
All Rooms Page tT|! v
Meeting Room Rental Page T|! v
Seminar Room Rental Page T |4 v
Training Room Rental Page T]|1 v
" WordPress Website Creation Training Course



VENUE SQUARE G)ME ALLROOMS  RENTAL RATES BOOKING FORM BLOG ABOUTUS CONTACT US
MEETING ROOMS

v..

SEMINAR ROOMS

TRAINING ROOMS

\_ This Is how your main navigation
DEMOUSER [ AUGUST 7, 2016 (EDIT) i :

. menu (with drop down menus)
WordPress Resources at SiteGround should look like.

WordPress is an award-winning web software, used by millions of webmasters worldwide for building their website or blog. SiteGround is proudl&o host this ...

. Next, let's go ahead and add some
[READ MORE... content to one of your pages -

. Click on “Meeting Room Rental”

C
)
)
C
@)
O
2
.Cj_)
@)
=
O
O
<

.:.
N
N

N
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Venue Square Customize . Edit Page Howdy, demouser i
— A

VENUE SQUARE “+. HOME ALLROOMS RENTALRATES BOOKING FORM BLOG ABOUTUS CONTACT US

Meeting Rooms

Once on the *Meeting Room
-...Rental” page, click “Edit Page”
(Edit) found on your admin bar.

C
)
)
C
@)
O
2
N
@)
=
O
O
<

Copyright © 2016 - Digital Pro on Genesis Framework - WordPress - Log out

N
N
N

N
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W @A VenueSquare ¥ <+ New ViewPage Theme Options Howdy, demouser K
: : Screen Options Help
&% Dashboard Edit page Add New >
A" Posts g , "
Meeting Room Rental Publish .
07 Media .
- Permalink: http://venuesquare.com/meeting-room-rental/ Edit Preview Ci.’nanges
M Pages "o
Advanced Layout Editor ¥ Status: Published Edit °.
-IE All Pages .
@ Visibility: Public Edit ‘.
_|C|_') Add New €7 Add Media | [#] Insert shortcode Vicual [Tt " i - .
_ fill] Published on: Feb 17, 2016 @ 16:32 : ’ i i &
S Y E vty =i suERn = R . Let’s set the "Screen Options
O ool e .. before configuring the page.
Move to Trash Update °.
_,q_,J + Enfold Child Y
O - ( - 1)
2 | -Click “Screen Options”.
®) Appearance Page Attributes =
__ng v Plugins Daiasis
O Users =
(no parent) .
< Tools
Template
tal Settings
Default Template H
Shortcodes
Order
=] LayerSlider WP ;
Word count: 0 Last edited by demouser on February 17, 2016 at 4:32 pm Need help? Use the Help tab in the upper
right of your screen.
>
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W @A Venue Square

&% Dashboard

#* Posts

07 Media

Il Pages

All Pages
Add New

Comments
Portfolio Items

+ Enfold Child

Appearance
¢ Plugins
Users
Tools
tal Settings

Shortcodes

[~ LayerSlider WP

- 1t
Collance menii
S VNG WV ON PN NG

& <4 New ViewPage Theme Options

Howdy, demouser B

ﬂoxes

v/| Avia Layout Builder Excerpt Custom Fields

v/| Featured Image
Layout
1 column (e 2 columns

Additional settings

v Enable full-height editor and distraction-free functionality.

Discussion Comments

N

Author |V Page Attributes || Layout

Edit Page AddNew

Meeting Room Rental

Permalink: http://venuesquare.com/meeting-room-rental/ Edit

Advanced Layout Editor

7 Add Media | [#] Insert shortcode

B I e = i 6 —

1]
L
Iili
({Q
I
b

Screen Options

Publish

Preview Changes
¥ Status: Published Edit

@ Visibility: Public Edit

Visual Text

il Published on: Feb 17, 2016 @ 16:32
b Edit

Move to Trash

Page Attributes a

Parent

Qy
N

—
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want displayed on your page.
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CUSLOITI REeQireCL UKL | 7]

Robots Meta Settings

Layout Settings

Select Layout

Custom Body Class

Custom Post Class

Apply noindex to this post/page [7]

Apply nofollow to this post/page [:

t\J’

Apply noarchive to this post/page

. Default Layout set in Theme Settings

-
e

This shows additional widgets on
your page. You may choose to
remove them again via the “Screen
Options” panel.

For the Genesis Digital Pro theme,
*we Will select the first layout
(Content left, sidebar right).

S
\
N

gl
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7 Add Media [ Insert shortcode Visual L& irask Y-Status:pubished Rgly
File v Editv Insertv Viewv Formatv Tablev Tools v i @ Visibility: Public Edit :
> P You have two types of editor that
=y =y = = = 2 v ‘w " e - 5 e :
Rl L= S 4% s 0 L SO comes with WordPress by default -
v i v i v — = me ¢ = K3 = v HINSHCO Ok DUE 45 : " I
Paragraph Font Family Font Sizes = . L T | Q = @ A (?) m . ‘. . The V|Sua| / TeXt edltorS.
Rent a meeting rf)om for your business meetings and discussions. Ideal corporate setting with Move to Tr:a;ﬁ S . " The Text editor on the other hand
comfortable seating for 10 - 18 pax. . . <. 2llows Vou 1o 'np t code (e 9
+ “e., = WS yOu | u g.
(- ., . ‘.
% | Page Attributes ., @ HTML, CSS).
@) e Parent T
(q)) P——— .. The Visual editor provides you with
= Y “WYSIWYG (What You See is What
emplate : :
5) You Get), sort of like Microsoft
- Tl | .D.e.fault Template ¥ WOl’d.
s der
Order
< P o .. )
Word count: 18 Draft saved at 7:15:35 am. Last edited by demouser on August 7, 2016 at 7:13 am 0 e, .. NOW |et S add SOMme Content!
Need help? Use the Help tab in the upp.el: B _
Theme SEO Settings A right of your screen. ’ Type IN some text.
Document Title [?]
Featured Image -
Characters Used: 0
2
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O Add Media | [#] Insert shortcode Vicual | it
File v Editv Insert v Viewv Formatv Tablev Tools v
B I U K|E[oEvE ==L REBY™NC B e
Paragraph v FontFamily v " Eont Sizes, v — = m ¢ S22 g Q0 O = © A v @
Rent a meeting room for your business meetings and discussions. Ideal corporate setting with ot | : |
5 comfortable seating for10 -18 pax. el o ets apply some formatiing.
s | e .
8 Amentdesinelode: =00 e M To format your text, highlight your
> - ~ "+ text and select the formatting
-C-lj:) . Fr‘ee N TR oo Op’[lons
®) * Flip chart UUIUUURPPPPPPRRRRTEEEEE AR
= e Projector] Next, add a horizontal line.
g » Whiteboard
e Refreshments
- /
ul » li
Word count: 27 Draft saved at 7:16:36 am. Last edited by demouser on August 7, 2016 at 7:13 am
s
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O Add Media < .|¥|. Insert shortcode Vicual | | Taxt
File v Editv Insert v View . Format v Table v Tools v
B I U G =v v £ = ZLREBYXNCB o=
Paragraph v FontFamily ¥ FontSizes v —'.§.. A « 5 ; .§_§ B ¢ O = ©® A v @O
E . . . . e T S, )
D Rent a meeting room for your business meetings and discussions. Ideal ¢orporate setting With. . Next, let's add a photo.
S comfortable seating forto-18 pax. ~ Tree o e L | |
SR | e e Click “Add Media”.
2 Amenities include: e
2 *-. Before that, we’ll add a horizontal
2 »HeeWDL D ine.
% « Flipchart e
< e Projector T
e Whiteboard LT
e Refreshments LT
4
p
s
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Click “Select Files” and add a
Insert Media Insert Media * phOtO.

Create Gallery Upload Files Media Library

Featured Image

It Is recommended to use your own
o "~ high quality custom photography.
However it you do not have any,

you can find stock images via the
following sites:
- freeimages.com
- morguefile.com
Maximum upload file size: 128 MB. - 1 23 rf ) Com

Drop files anywhere to upload et .

or

Select Files

Take note to also compress your
image file sizes if they are too
huge. Read this tutorial:
http://www.wpbeginner.com/

| Insertinto page | beginners-guide/speed-wordpress-
save-images-optimized-web/

C
)
)
C
@)
O
2
.Cj_)
@)
=
O
O
<

Ny
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N

N
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http://freeimages.com
http://morguefile.com
http://123rf.com
http://www.wpbeginner.com/beginners-guide/speed-wordpress-save-images-optimized-web/

Insert Media Insert Media X

Create Gallery Upload Files Media Library

Featured Image (500 x 981 \

All media items s All dates A Search media items... Edit Image

Delete Permanently

Insert from URL

URL  http://demowebsite56.site

Title  analytics group meeting

l=
.|C|_:) Caption
5
O e Select Image display details and
2 Description click “Insert into page”.
N
@) ’
% ATTACHMENT DISPLAY SETTINGS . o ’
O Alignment None % o
< .
Link To  None g o
\ Size [ Large - 1024 x 670 9 o .

/3
1 selected
nsert into page
Clear
_
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07 Add Media

File v Editv Insertv View v

Paragraph v B I U €6

Font Family v FontSizes v

Visual  Text Publish A

Format v Table v

Preview Changes

LN

9 Status: Published Edit
@ Visibility: Public Edit
¥0 Revisions: 3 Browse

"**e.... [l Published on: Dec 12, 2016 @ 02:58

Move to Trash

Parent

AllRooms,.+*°*"" %

Word count: 36

Pl e O ALY

Book a meeting room today. USRS Template
ettt o Default Template %
Go to booking form —| - °
Order
0

Draft saved at 3:19:50 am. Last edited by demouser on December 12, 2016 at 3:14 am
Need help? Use the Help tab above the
screen title.

Page Attributes A

-+ We'll add another horizontal line
after the image.

.. Next, let's create a call-to-action.

N
N
N

gl
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Q7 Add Media Visual  Text Publish -

File v Editv Insertv View v Formatv Tablew
Preview Changes

Paragraph v B I U €6 :=

. . 9 Status: Published Edit
Font Family ¥  Font Sizes

@ Visibility: Public Edit

¥0 Revisions: 3 Browse

it Published on: Dec 12, 2016 @ 02:58

= " eBdit Now we’re going to create a
CC) MovetoTra.s.h“-.. hyperllnk'
O
Q9 Highlight the text you would like to
= Page Attrib At b : : :
N age Attributes ‘- make clickable and click on this
=% Parent chain icon.
O All Rooms :
O
< Book a meeting room today. Template
Default Template ¥
(Go to booking form — )
Order
0
Word count: 36 Draft saved at 3:19:50 am. Last edited by demouser on December 12, 2016 at 3:14 am
Need help? Use the Help tab above the
screen title.
e
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Q7 Add Media Visual  Text Publish -

Filew Editv Insertv Viewv Formatv Tablew
Preview Changes

ParagraphvBIQ“EE'E'::i::({’)ag‘\,: e

9 Status: Published Edit

FontFamily ¥ FontSizes v — ¢= 3=» = A v v ©

@ Visibility: Public Edit
¥0 Revisions: 3 Browse

i1l Published on: Dec 12, 2016 @ 02:58

= Edit Enter the title of the page you

L would like to link to. In this case it
(CC)) Mave o liasn would be the booking form page.
o . .

= rageAttnbutes . Next, click on the suggested

O Parent L. **dropdown selection, and hit “Enter”
% AllRooms * T N on your keyboard.

g Template

l booking|

Booking Form Default Template ¥

Order
0

Word count: 36 Draft saved at 3:19:50 am. Last edited by demouser on December 12, 2016 at 3:14 am
Need help? Use the Help tab above the
screen title.

Theme SEO Settings A

l.
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&) @A MyBlog B 4+ New View Page Howdy, demouser

&% Dashboard 0y Add Media “e.. . ol 9 Status: Published Edit
. . e Visibility: Public Edit
O Jetpack File v Editv Insertv View v Formatv Table'w , . VIsRiNtyx FUDRO AL
# Posts Paragraph v B I U ¢ = v = v = [Z]| =[RIR N W, O Revisions: 3 Browse
o , FontFamily v FontSizes v — ¢ =2 H ¢ Q = A v éﬂ; v .9 il Published on: Dec 12, 2016 @ 02:58
<7 Media : - . Edit
M Pages
| Move to Trash
-+ All Pages L. . .
C ® e ° o L4
¢D) Add New “e.. g
"E Page Attributes  ° -, S
'® ¥ Comments Teel, . .
Parent e, ° . .
O -..Now update your page and view it
Genesis All Rooms : :
9 live.
U) Appearance Template
@)) Plugins Default Template 4
C
O Users Order
O o
< Tools
Settings | Need help? Use the Help tab above the
demowebsite56.site/booking-form 2 ¥R Rcresn fite.
Collapse menu
Go to booking form —
Featured Image A
>
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PRIMARY SIDEBAR WIDGET AREA

Meeting Room Rental Ths s the rimary Sidebar Widget Arec.

You can add content to this area by

Rent a meeting room for your business meetings and discussions. Ideal . RN :
visiting your Widgets Panel and adding

corporate setting with comfortable seating for 10 — 18 pax. new widgets to this area.

Amenities include:

e Free WIFI

» Flip chart

» Projector
 Whiteboard

» Refreshments

c
2
S
O Here's how your page looks on the
2 front end.
op)
O)
=
O
O
<
Book a meeting room today.
Go to booking form
s
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W @A VenueSquare ¥ 4+ New Theme Options

#% Dashboard

Posts Add New

A Posts All (1) | Published (1)

Bulk Actions ¢ All dates

.........
Image

All Posts

( Add New

Categories SR
*Hetle wqrld!

Tags

07 Media

Image Title

Pages

Bulk Actions §  Apply

Comments
Portfolio Iltems

Enfold Child

Appearance
v Plugins
Users
Tools
i Settings

Shortcodes

=] LayerSlider WP

-~
A

ntre.."'ooooo

All categories &

Filter

Author

Edit | Quick Edit = Trash® View « . , ,

Author

. Uncategorized — a

* ¢« Lategories

Howdy, demouser [

Screen Options Help

Search Posts

1 item

Categories & Date

Published
18 hours ago

. Déte.."‘oooc

---.. 1. Navigate to "All Posts".

e 2. Click “Add New”.

)
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W @ VenueSquare B <+ New ViewPost Theme Options Howdy, demouser B

3 Screen Options Help
#» Dashboard Edit Post Add New
A Posts et g : ;
(How to Conduct an Convincing Semlnar) <q... Publish
All Posts T
Permalink: http://venuesquare.com/how-to-conduct-a...nvincing-seminar/ Edit Sy Preview Changes
Add New S
Categories ... | ¢ Status Drak Edt
- ® e, 2
- fog ® Visibifity: Pyblic Edit
O ©7 Add Media | [#] Insert shortcode Visual | Fext ik G . I. .
-'E 07 Media S : T i Published on: Feb 18, 2016'@ 0907
O B I = —E& - = ==& BN X Edt
P R e, .
O o Paragraph v U = A v Bl © Q & = 0 & .. 1. Enter the post title.
Move to Trash Update
Comments R ) R
9 oooooooooooooooooooooooooooooooooooooooo"" 2. Enterthepostcontent.
-Cf_) " Portfolio Items (Loremipsum.)4"""""""”'”
@)) . Enfold Child Format .
E e »# Standard
@) Appearance ;
O ’ . Link
< ¢ Plugins Quote
Users Gallery
Tools Video
I
lal Settings ek
Audio
Shortcodes
P
= LayerSlider WP Word count: 2 Last edited by demouser on February 18, 2016 at 9:07 am Categories A
>
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W @A Venue Square
#% Dashboard

A Posts

All Posts
Add New
Categories

Tags

07 Media

Pages
Comments
Portfolio Items

+ Enfold Child

Appearance
v Plugins
Users
Tools
il Settings

Shortcodes

a] LayerSlider WP

Collanse menu
LOHapse menu

&

== New View Post

P
Word count: 2

Theme Options

Last edited by demouser on February 18, 2016 at 9:03 am

Howdy, demouser B
Quote

Gallery
Video
Image

Audio

Categories

All Categories Most Used

v'| Uncategorized

@New Cat@ ‘ e © ® o ©

Tags

Add

Separate tags with commas

Choose from the most used tags

Featured Image a

Set featured image

Don't display image on single post

.. Click “+ Add New Category” to
assign this post under a category.

Qy
N

)
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W @A VenueSquare B <4+ New ViewPost Theme Options Howdy, demouser K

@ Dashboard Gallery
Video
A Posts
Image

All Posts Audio

Add New

Categories .
+— P Categories s
C Tags Word count: 2 Last edited by demouser on February 18, 2016 at 9:03 am
.|q_:) 0 All Categories Most Used
- 47 Media
- 7 Uncategorized .- 1. Enter the category name.
O Comments + Add New Category , &5
+— o . . ( )
D Portfolio ltems e e ..--2. Click “Add New Category”.

Tips > & 15
@)) Enfold Child e e s B o1
C — Parent Category — et
@) Appearance y
[©) @i New Ca@
<E v Plugins
Users
Tools Tags A
i Settings Add

Shortcodes

Separate tags with commas

> LayerSlider WP Choose from the most used tags

Nnentl

N
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VY 4 Venue Square
#®» Dashboard

A Posts

All Posts
Add New
Categories

Tags

07 Media

B Pages
Comments
Portfolio Items

Enfold Child

Appearance
v Plugins
Users
“ Tools
| Settings

Shortcodes

(=l LayerSlider WP

O IMAaniti
) e ey

&

<4 New ViewPost Theme Options

Thank you for creating with WordPress.

Howdy, demouser B

v Tips

v'| Uncategorized

+ Add New Category

<>

— Parent Category —

Add New Category

Tags A

Add

Separate tags with commas R

Choose from the most used tags o

Featured Image . a

@atured i@

Don't display image on single post

Version 4.4.2

—
Equinet
Academy

|04

Click “Set Featured Image”. Your
" feature image will appear in your
blog roll.
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Featured Image

Upload Files Media Library

= All dates ATTACHMENT DETAILS

Meeting-Room.jpg
g4 February 18, 2016

1678 x 1119
Edit Image

Paetelermanenily. . . . . .. ... 1 _ Upload/seleCt d featured
image.

http://venuesquare.com/w

Meeting Room

Caption

2. Click “Set Featured Image”.

Alt Text

)
C
O

)
C
@)

@)

9

N
@)

=

O

O

<

Description

Slide link

Shortcodes Ultimate »’

VAR TN R

Set featured image

.
Qy
N

>
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% @A VenueSquare ¥ <4 New ViewPost Theme Options Howdy, demouser K

Dashboard
— Parent Category — S
A Posts Add New Category
All Posts
Add New
Categories Tags
Tags
Add
07 Media
Separate tags with commas
Pages
Choose from the most used tags "
S You have just added a featured

Portfolio Items image to your post.

Featured Image 5

t Enfold Child

Appearance

v Plugins

)
C
O

)
C
@)

O
O

=

)
@)

=

_G

O

<

Users

Tools

il Settings

Remove featured image

Shortcodes

Don't display image on single post

=] LayerSlider WP

Collanse menu
WAVNIIGWVOS THII TR

N
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W @ VenueSquare B -4 New ViewPost Theme Options Howdy, demouser B
i . Screen Options Help
@¢ Dashboard Edlt PoOSt Add New
A Posts AR 2 .
How to Conduct an Convincing Seminar Publish 4
All Posts o £ :
i Permalink: http://venuesquare.com/how-to-conduct-a...nvincing-seminar/ Edit Preview Changes
ew
Categories Advanced Layout Editor 9 Status: Published Edit
-+
C Tags - @ Visibility: Public Edit ' ' :
O € Add Media | (%) Forms | [#] Insert shortcode Vet | Text 0 D T R Insertlng d Vldeo
-IE 07 Media fit] Published on: Feb 18, 2016 @ 09:07
e b i link b-quote del ins img ul ol  li code @ more | Cclosetags “ml Edit
P .
O sitt oren ipsun 1. WordPress detects youtube links
= ¢ Move to Trash Update .
Forms
9 and automatically renders your
— Corrs i s https://www.youtube.com/watch?v=eIho2S0ZahI . .
P i | youtube link into an embedded
@)) Portfolio Items bbb - :
- video.
= {% Enfold Child * # Standard
O Link
< Appearance Quote
v Plugins Callery
Tools Image
Audio
[l Settings
Word count: 3 Draft saved at 3:15:57 pm. Last edited by demouser on February 18, 2016 at 9:07 am
> Shortcodes
Categories A
>
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W) @A MyBlog ® 0 < New View Post Howdy, demouser

Screen Options ¥ Help ¥
2 Dashboard Edit Post Add New
@ Jetpack
Post draft updated. Preview post
A Posts
All Posts How to Create an Awesome Seminar Publish A
Add New Permalink: http://demowebsite56.site/2016/12/12/how-to-create-an-awesome-seminar/ Edit Save Draft Preview . i .
— Inserting a video:
Tags 04 Add Media 9 Status: Draft Edit

Visual Text
@ Visibility: Public Edit

9] Media Flev Ediv ksetv Vieww Fomate fabls« 1. WordPress detects youtube
B Pages Paragaph v B I U & Ev Ev E = = &R R B o Do 1420106 03:68 links and automatically
e il A LB — o IO 5= v T . Gy renders your youtube link into
. Lorem ipsum. V. an embedded video.

Categories A *
Appearance

2 Click "Publish” and View Post.

Plugins All Categories Most Used

Users Select / Deselect All

Tools 7| Tips

Settings

Uncategorized

Collapse menu + Add New Category

-
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Home All Rooms Rental Rates Booking Form Blog

| DECEMBER 12, 2016

How to Create an Awesome
Seminar

Lorem ipsum.

Your post is now live.

How to speak so that people want to listen | Julia... @@

o v
;" -
. »- > l.

: 1

=
2
C
O
O
O
=
n
@)
=
=
O ot
< ;

Qy
N

N
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A MyBlog ® 4 New

pasnuoearc Reading Settings
Jetpack
Front page displays *) Your latest posts
Posts
¢ static page (select below)
Media S
pages Front page: e OS.O;:(?(II — v
Comments SR o e .
: — Select — e, ¥
o 3L : :
= N Next, we're going to set up the blog
-+ R . a e
- Coo, e
8 Appearance Blog pages show at most 3 posts Yoo,
e Plugins 1. Navigate to Settings” =>
= _ “Reading”
N Users Syndication feeds show the 10 TN el . g
®) most recent T,
- Tools ... |
= 2. Select “A static page”.
S Settings For each article in a feed, o) Full text
<L show
General Summary
W dle
Reading Search Engine Visibility Discourage search engines from indexing this site

Discussion : : :
It is up to search engines to honor this request.

Media

Permalinks

Save Changes

TinyMCE Advanced

Qy
N

N
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A MyBlog W 4 New

uashboaIc Reading Settings
Jetpack
Front page displays Your latest posts
Posts
¢ A static page (select below)
Media
Pages Front page: Home
Comments ’
Posts page: | Blog
- Genesis T
® eoc
C o
@) Appearance Blog pages show at most 3 posts e, .
" Plugins -Select Home and Blog.
- . .
-CTJ Users Syndication feeds show the 10 e
most recent
O) Tools
=
8 Settings For each article in a feed, e Full text
< show
General Summary
Writing
Reading Search Engine Visibility Discourage search engines from indexing this site

Discussion . . :
It Is up to search engines to honor this request.

Media

Permalinks

Save Changes

TinyMCE Advanced

Qy
N

N
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Home AllRooms Rental Rates Booking Forbout Us Contact Us

Blog

DEMOUSER | DECEMBER 12, 2016 (EDIT)

How to Create an Awesome Seminar

E Lorem ipsum. https://www.youtube.com/watch?v=elho2S0Zahl ..
)
*g' Lk g Here's how your Blog Page looks
® like now. It displays all your latest
1D posts in reverse chronological
) format.
CCD FILED UNDER: TIPS
._5
[©)
<C

DEMOUSER [ DECEMBER 12, 2016 (EDIT)

WordPress Resources at SiteGround

WordPress is an award-winning web software, used by millions of webmasters worldwide for building their website or blog.

SiteGround is proud to host this ..

S
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Formidable

Forms

Add New % % W W 17 (112)

Venue Square New Theme Options

Fhgulock Add Plugins upload Piugin
Posts
Search Results  Featured Popular Recommended
Media
Pages
Comments
Formidable Forms
Portfolio Items
Beautiful forms in 60 seconds. The
Enfold Child WordPress form builder that
enables you to create forms with a
Appearance simple drag-and-drop interface
and in-place editing.
Plugins
By Strategy11

200,000+ Active Installs
Users

Tools Formidable Email

Settings Shortcodes

Create shortcodes with unique
identifiers to use in your
Formidable Email Notification
Settings. Change email addresses
globally from one location.

Shortcodes

LayerSlider WP

By Thom Stark

Favorites

Install Now

More Details

Last Updated: 5 days ago

v Compatible with your version of WordPress

Install Now

More Details

Howdy, demouser B B

Help v

Keyword 3% Gormidable)

47 items « < 1 |of 2 ) »

Formidable PRO2PDF Install Now

Map web forms to PDF forms then More Details

with one simple shortcode -
display a link on any post, page,
form, or view the merged PDF on a
PC or mobile device.

By Alexandre S.

' & 6 6. & 40 Last Updated: 2 days ago

400+ Active Installs v Compatible with your version of WordPress

Formidable Honeypot Install Now
Add SPAM protection to your More Details
Formidable forms without
annoying your visitors with
Captchas, math, or other fields.
By Ryan Pilling

A A A A A .. AR A A A RO S A L e

We'll now proceed to create a contact page.

Let’'s head over to “Plugins” => “Add New” and search for “Formidable Forms”.

113

WordPress Website Creation Training Course




)
C
O

)
C
@)

O
O

=

)
@)

=

_G

O

<

W @A Venue Square
#% Dashboard

» Posts

Entries

Styles

Import/Export

Global Settings

AddOns
Comments

Portfolio Iltems

+ Enfold Child

Appearance

v Plugins

Users
Tools

il Settings

& -4 New Theme Options Howdy, demouser [

Screen Options

Forms AddNew -

My Forms (0) | Templates (1) Set e S
Bulk Actions v  Apply . i
ID Form Title K ‘e, Entries Key Shortcodes
No Forms Found. Add New o S
ID Form Title e *+,_  Entries Key Shortcodes
Bulk Actions v Apply i SRy

Once the plugin is installed and
activated, navigate over to
‘Forms”.

|"*--Next, click “Add New”.

Qy
N
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# Venue Square

#% Dashboard

# Posts

07 Media

Pages

Import/Export
Global Settings
AddOns

® Comments
Portfolio Items

£+ Enfold Child

Appearance
& Plugins
Users
» Tools

Settings

& 4 New Theme Options

Build New Form

Build Settings

Entries Switch Form «

(Click to add description)

1. Name your form

ooooooooooooEOImKey:. .bEnqr

ooooo.mwem;rag.‘Oo....

2. Click or drag a field to
add it to your form

Add Fields Here

Or load fields from a template Contact Us 2 Load Template

/[?_} 3. Save your form

A

Save Draft

Form Shortcodes Show

§ Status: Draft

Fields Layout

Howdy, demouser .

Screen Options

Preview

Single Line Text

Checkboxes

Dropdown

Website/URL

Paragraph Text

Radio Buttons

Email Address

reCAPTCHA

is submitted or when a payment is

received? Use Twilio

with this form.

gl -}

-1, Enter atitle here.

-2, Start clicking/dragging the
fields from the right.

.
Qy
N

=1
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# VenueSquare ¥ <+ New Theme Options Howdy, demouser -

Screen Options

& Dashboard Build New Form

# Posts : : : T
; Build Settings Entries Switch Form «
& i Save Draft Preview

07 Media

Form Shortcodes Show

? Status: Draft ..s.eooo+ 1. Enter the field names.

(Click to add description) Form Key: bzngr R o b s o o

.........---°°'N70:/e.toTrash

Contact Page

- e © © ottt 0. 2 — . o. " "
Entries < |...-:2. Add the following fields as
Styles Fields Layout Lo 3 1N 1 Wel |
Import/Export (Click to add description) et T o *F
Global Settings | Single Line Text A ® Paragraph Text A - Name
AddOns Field Options (ID 8) v Checkboxes Radio Buttons - Emal |

i Dropdown Email Address — P h O n e
Pocp i pa Website/URL reCAPTCHA _ Message

+ Enfold Child ! ) ProTip: Want a text when this fgrm |
‘ is submitted or when a payment is

|
received? Use Twilio with this form. !

)
C
O

)
C
@)

O
O

=

)
@)

=

_G

O

<

Appearance
Plugins
Users

“ Tools

| Settings

venuesauare com/wn-admin/admin nhn?naae=formidahle&frm action=new#

Qy
N

>
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W @ Venue Square

94 wicuia

Entries

Styles
Import/Export
Global Settings
AddOns

¥ Comments
Portfolio Iltems

Enfold Child

" Appearance

» Plugins

» Users
Tools

i Settings

Shortcodes

i~ LayerSlider WP

rallane —
allanca man:
@ LOHapse menu

& <+ New Theme Options Howdy, demouser B

Form Shortcodes Show

Contact Page

§ Status: Draft

(Click to add description) Form Key: bznqr

Move to Trash

[ ° ° o
e o g
R O Fields Layout
® o ° .
o o ° N
° e,
e o, ce., . Single Line Text Paragraph Text
LAY
Email tre.,, ,
e, ., Checkboxes Radio Buttons
o o ° .
[ ) ° ° N
*elsl.l, . _ Dropdown Email Address
[ )
® o * o s .
()
Website/URL * *reCAPTCHA
Phone s
= . * e &\
| () Pro Tip: Want a text when this form |
i is submitted or when a payment is |
received? Use Twilio with this form. !
Message Cr ‘T‘

(Click to add description)

Field Options (ID 11) :

.. Once you have completed adding
“your form fields, click “Create”.

You may mark the fields as
" required by clicking on the
asterisks.

Qy
N

—
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W @ VenueSquare B 4 New Theme Options Howdy, demouser B

Screen Options

#% Dashboard Setti ngs

¥ FPosts Build Settings Entries Switch Form ~ —
Form Shortcodes Show review

07 Media

§ Status: Published

Move to Trash

Contact Page

Form Settings All form entries will be emailed to
General E /) Pro '_ Have a long form that takes time to complete? Let logged-in users save a draft and return i Customization yO U r ad m l n em al | Set from
Form Actions < ‘ s | Insert Fields Advanced ’ Settl ﬂ g S "’ => ’ G eﬂ e I’a| "’ 5

Import/Export

)
C
O

)
C
@)

O
O

=

)
@)

=

_G

O

<

Customize HTML On Submit © e e Oy S S35 Fields from your form: IDs | Keys
Global Settings "°°-o..,........
AddOns L v : TtreeeeeeennL L oL Next, click Form Actions to manage
® Comments ~ | your automated emails,
Show the form with the confirmation message " ‘
A Portfolio Items
Helpers:
£+ Enfold Child Do not store entries submitted from this form
Appearance
PP AJAX
v Plugins
Load and save form builder page with AJAX
Users
‘* Tools X
Styling & Buttons
sl Settings
Style Template Alwavs use default s
g
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Contact Form § Status: Published
Move to Trash
Form Settings
| . : Customization

Genera () Pro Tip: Make front-end posting easy. Upgrade to Pro.

Form Actions Insert Fields Advanced
- Customize HTML Add New Action E‘ V. do Fields from your form: IDs | Key
- --.-..,.... Name [8]
% WA Eo% RN i hs . Email Address [9}

7] Email Notification B A : oo
8 t Phone il Click on the mail icon to add a new
Message RESAI S o i : ; :
- +--.1.... action (client automated email
+~ Helpers: re |
N ply).
@) Entry ID Entry Key
C P E
< — User I ntry created
U J
2 Editey Ldsited
Site URL Site Name
Default Msg Default HTML
Thank vou for creating with WordPress.
l.
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S
)

N

—
Form Settings
General () Pro Tip: Make front-end posting easy. Upgrade to Pro. EHSEam ZEH0R
Form Actions Insert Fields Advanced
Customize HTML Add New Action ~ Fields from your form: IDs | Keys
Name (8]
& Email Address \ 9]
[~] Email Notification v ..
- Phone [10]
& Message ..t |.... Click on the “To” field.
+— [%7] Email Notification s DB | e “°®
% Help.er.s; ....... .
O o e sveever e s St .. Click Email Address.
ofF et
— To S f e Sten cc 8cC User IP Entry created . .
N 9] < | This will send an automated reply
@®)) Entry updated . ; .
l= From rsitename] <tadmin_emaill> Reply To to your cilents’ email addresses.
% Site URL Site Name
Subject
<E Default Msg Default HTML
Default Plain
Message
[default-message]

Equinet
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W @ VenueSquare B 4 New ViewPage Theme Options Howdy, demouser [

Screen Options Help
% Dashboard Edit page Add New
A Posts ,
Contact Us Publish
07 Media
Permalink: http://venuesquare.com/contact-us/ Edit Preview Changes
|l Pages
Advanced Layout Editor § Status: Published Edit
E All Pages
= @ Visibility: Public Edit
O Add New 07 Add Media @) Forms< 9 lnsegt §h.OI;tC.Ode ey | & Visibility: Public Edit
_E ; 3 o 1] Published on: Feb 17, 2016 @ 16:33
=) Forms we = 2 66 — = = = 2 R == - ‘°--...,..... “u : . 0 3
8 f B I | SR =B/ e Navigate to your “Contact Us
Comments Paragraph v U = A v [l @ Q £ = Y @ [ : :
Move to Trash e - - - .. page and select the form’s
_lq_,J " Portfolio Items
5 ([fo,.midable id:z]) shortcode to render the form.
bt Erod Clakd Page Attributes '~
@)]
E Appearance Paca
S, v Plugins
O & (no parent) A
< Users
Template
" Tools
Default Template :
i Settings
Order
Shortcodes
0
=] LayerSlider WP p _
: Word count: 0 Last edited by demouser on February 17, 2016 at 4:33 pm Need help? Use the Help tab in the upper
Collapse menu right of your screen.
>
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VENUE SQUARE

C
o
C
O
O
D
=
®)
=
O
O
<

Contact Us

Name *
Email Address *

Phone *

Message *

SUBMIT

HOME

ALL ROOMS

RENTAL RATES

BOOKING FORM

S
\
N

gl
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Voila! Your contact form is now live.
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Add Plugins Upload Plugin

Search Results  Featured Popular Recommended  Favorites Keyword 3 genesis dambuster

Genesis Dambuster Install Now

A Genesis only WordPress plugin that makes it More Details
easy to set up your pages for edge to edge

content. Ideal for full width Beaver Builder

templates.

By Russell Jamieson

Landing

ool R W (18) Last Updated: 2 months ago
4,000+ Active Installs v Compatible with your version of WordPress

Page
Creation

The Beaver Builder plugin is a page builder plugin and requires you to install the
Genesis Dambuster plugin in order to integrate well with Genesis themes.
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https://wordpress.org/plugins/genesis-dambuster/

b Installing Plugin from uploaded file: beaverbuilder.zip

04 Media Unpacking the package...

M Pages Installing the plugin...

® Comments Plugin installed successfully.

=) Forms

{9 Genesis

Install the Beaver Builder plugin via
file upload and click Active plugin.

¥ Appearance

A Plugins

Installed Plugins

Add New

)
C
O

)
C
@)

O
O

=

)
@)

=

_G

O

<

Editor

¢
sa Users

/ Tools

Ll Settings
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We have to set a few things straight
first (e.g. making the page full

Scripts . width) before we can use Beaver
Builder.

Page-specific Scripts |
1. Navigate to your home page.

c

= | | | - | . 2. Scroll down to Genesis

S Suitable for custom tracking, conversion or other page-specific script. Must include script tags. Dambuster fields

O

q) .

D i 3. Make sure all the fields are
enesis Dambuster A :

®) ~ checked EXCEPT the following:

% Enable Template Width Header Above Content Below Content Footer Background Helper Classes P EEEEE R R - ?emove Headel’

32 Enable Tweaks @ 7 ‘ - Remove Prim. Nav

- Remove Second. Nav
- Remove Footer
- Remove Widgets

N_
4. Update the page
_
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Text Editor Page Buildel¥ .

07 Add Media | (&) Forms  [#] Insert shortcode | °*

Visual  Text
File v Editv Insertv View~v Formatv Table Tools. v .
B I U GEYEYES SLREXN/PBO e
= Paragraph ¥ FontFamily ¥ FontSizes v — = e ¢ 5¢ o - = © A~ 0
% Now we can proceed to construct a
8 landing page with Beaver Page
D Builder.
) * Click Page Builder.
C
=
O
<C
o)
Word count: 0 Last edited by demouser on August 7, 2016 at 10:01 am
s
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@ Page Builder Tools o
» °
VENUE SQUARE HOME  ALLROOMS RENTALRATES  BOOKING FORM s
Row Layouts 2 v
----------------------------------------------------------------------------------------------------------------------------------------------------------------------- 1 Column .
2 Columns ‘.
3 Columns "
4 DROP A ROW LAYOUT OR MODULE TO GET STARTED! °.
- 4 Columns "
qD) .
B — o
(- 5 Columns ‘.
S :
----------------------------------------------------------------------------------------------------------------------------------------------------------------------- 6 Columns B .
D . Click Templates to add a template.
o Copyright © 2016 - Digital Pro on Genesis Framework - WordPress - Log out Left Sidebar
)
Right Sidebar
(@)
E Left & Right Sidebar
O
2 Basic Modules v
Advanced Modules v
WordPress Widgets o
Saved Rows v
Saved Modules v
A
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Layout Templates

H“

JETS HEAT

Let's Meat

Erjoy shrgde Iving wiEn Lon LS

Zen Life

Moon Landing

Janelle Awkward

BEAVER ACENCY
. S

-

Agency

Cancel

128

Select a template.
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0 Page Builder Add Content Templates Tools ©
b

VENUE SQUARE HOME  ALLROOMS RENTAL RATES BOOKING FORM BLOG  ABOUT US comAc;b.us
c
9
5 ‘~
O Enjoy simple living with Zen Life - Once you're done customising your
= template, click Done.
U) 5% . . . . . .
®) - special Zen Life master guide, you will be guided to becoming a
C ) - ”?r
S living a simple and easy life. We have helped thousands of people

reach their potential.
s
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How to Craft Magnetic Landing Pages

Think of the user objectives
Match the user objectives to your business objectives
Study your competitors’ website and list down both good and bad points

Become the customer. What are you looking for? What are your concerns”

Design a wireframe of your landing page before creating it
Copy leads design
Conduct usability tests (A/B Split Testing)
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X  Soved

You are customizing 2]
Venue Square

VENUE SQUARE HOME  ALLROOMS RENTAL RATES BOOKING FORN

Active theme ch
Digital Pro Ssehadl
DEMOUSER | AUGUST 7, 2016 (EDIT)
Site Identity > °
WordPress Resources at SiteGround
Colors >
Header Image 5 WordPress is an award-winning web software, used by millions of webmasters worldwide for building t
proud to host this ...
- 5 Front Page Image >
‘ ' I S t ‘ ’ l I I I S I I l g Front Page Content Settings > [READ MORE...]
Menus >
W b | t o |
e S I e Static Front Page >
Site Layout >
Appearance >
Commaents< and Trackhacks S

Premium WordPress themes usually come with a built-in theme customiser. Otherwise,
you will need to possess some coding knowledge if you wish to change the site
appearance through the style.css / custom.css file.

Navigate to to Appearance => Customizer => Header Image

13 WordPress Website Creation Training Course




X =

Customizing

Header Image

VENUE SQUARE HOME ALLROOMS RENTAL RATES BOOKING F¢

0,
O . .
(- While you can crop images to your liking
Q] after clicking Add new image, your theme
B recommends a header size of 600 x 140
D pixels. DEMOUSER [ AUGUST 7, 2016 (EDIT)
= Current head 7
2 W i WordPress Resources at SiteGround
) No image set
4 N | o e T e o e T o e e i e S S e A r nOC YO ¢ . : : y -. ye v 11 . , s 15/ e o0 00 I
= WordPress is an award-winning web software, used by milliops of webmasters worldwide for buitdin- Click Add New |mage.
2 AdNEWiMage o ooecoonsessoossosemreoreressnsnnts
% proud to host this ...
@) [READ MORE...]
C
@
O
)
op)
D)
O
-.
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X Save & Publish

Customizing

Header Image

T . .VENUE S_éUARE HOME ALL ROOMS RENTAL RATES BOOKING FORM BLO(

While you can crop images to your liking
after clicking Add new image, your theme

recommends a header size of 600 x 140 *.,
pixels. DEMOUSER / AUGUST 7, 2016 (EDIT) ...

Current header WordPress Resources at Siiéémund
VENUE SCIUARE

Hide image Add new image proud to host this ...

WordPress is an award-winning web software, used by millions of webmasters worldwide for<wjlding their w

Your logo is now uploaded.

Previously uploaded

Click Save.
ENUE S UUARE [READ MORE...]

Yo Randomize uploaded headers

D
O
-
S
| -
S
D
Q
Q

<

=

»

Q

=
®)

=

G
-

O
9P,
D

O

.:.
N
N

N
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#% Dashboard

) Jetpack

Posts
41 Media
W Pages
» Comments

=) Forms

9 Genesis

M Appearance

Themes
Customize
Widgets
Menus
Header

Editor

A Plugins

D)
@)
-
M
| -
M®
D
Q.
Q.
<C
O
=
D)
@)
%J
@)
£
2
-
@)
-+
0
)
O

s Users

& Tools

WldgEtS Manage in Customizer

Available Widgets

To activate a widget drag it to a sidebar or click on it. To deactivate a widget

and delete its settings, drag it back.

Archives

A monthly archive of your site’s
Posts.

Categories

A list or dropdown of categories.

Formidable Form

Display a Formidable Form

Genesis - Featured Posts

Displays featured posts with
thumbnails

Meta

Login, RSS, & WordPress.org links.

Calendar

A calendar of your site's Posts.

Custom Menu ,.° X

Add a ¢ustom menu to your

. sidebar.

Genesis - Featured Page

Displays featured page with
thumbnails

Genesis - User Profile

Displays user profile block with
Gravatar

Pages

A list of your site's Pages.

Primary Sidebar

This is the primary sidebar if you are using a two

or three column site layout option.

4

Front Page 1

Front Page 2

Front Page 3

A

Equinet
Academy
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We can add the following web
elements to your sidebar:

e Contact form

e Advertisements

e Email opt-in forms

¢ [nternal navigational links

¢ Related content

¢ Blog categories and recent posts
e [mage gallery

¢ \/ideos

e Social media profiles

Let's go ahead and add a
contact form. To add a form,
simply drag and drop the widget
to the allocated sidebar.
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VENU E S SUARE HOME ALL ROOMS RENTAL RATES BOOKING FORM BLOG ABOUT US CONTACT |

CONTACT FORM

Meeting Rooms

Rent a meeting room for your business meetings and discussions. Ideal corporate setting Bl Addiais Your COntaCt form Wl | | NOW ShOW on

with comfortable seating for 10 - 18 pax. .

L.~ your sidebar.

Amenities include: Phone *

e [ree WIFI

D
O
-
S
| -
S
D
Q
Q

<

=

»

Q

=
®)

=

G
-

O
9P,
D

O

e Flip chart Message *
* Projector
e Whiteboard
* Refreshments
4
SUBMIT
5
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¥ Dashboard Wldgets Manage in Customizer

»

4
s

8
£33

D)
@)
-
M
| -
M®
D
Q.
Q.
<
O
=
D)
@)
%J
@)
£
2
-
@)
-+
%)
)
O

9 Genesis

Appearance

Themes
Customize
Widgets
Menus
Header

Editor

Plugins

Users

/ Tools

Settings

Categories

A list or dropdown of
categories.

Formidable Form

Display a Formidable Form

Genesis - Featured Posts

Displays featured posts with
thumbnails

Meta

Login, RSS, & WordPress.org
links.

Custom Menu z

Add a custom menu to your,
sidebar.

Genesis - Featured Page

Displays featured page with
thumbnails

Genesis - User Profile

Displays user profile block
with Gravatar

Pages

A list of your site's Pages.

Front Page 2

Front Page 3

F.do.ter 1

Footer“widget area.
Custom Menu

Title:
Site Links

Select Menu: — Select — 4

Delete | Close

@ Jetpack
Available Widgets A Primary Sidebar . Footer 2
Posts To activate a widget drag it to a sidebar or click on it. To deactivate This is the primary sidebar if you are using a
Media a widget and delete its settings, drag it back. two or three column site layout option.
Footer 3
Pages Archives Calendar Formidable Form
Comments : | After Ent
A monthly archive of your A calendar of your site’s
Forms Site’s Posts. Posts. Front Page 1
Contact |

Equinet
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Let's add a custom menu (e.g. Site
Links) to the first footer widget
area.
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A MyBlog B 4+ New Howdy, demouser

Screen Options ¥ Help ¥

Dashboard WV [=1a]V[l Manage with Live Preview
Jetpack

Edit Menus Manage Locations
Posts
Media Edit your menu below, or create a new menu. @ . , .
Pages
Comments Pages A Menu Name Main Navi TteeelL, S

=) Forms

... Navigate to Appearance => Menus

Genesis Cortaclla Drag each item into the order you prefer. Click the arrow on the right of the item to reveal additional and click “Create a new menu’.
configuration options.

Most Recent View All Search Menu Structure

D)
@)
-
M
| -
M®
D
Q.
Q.
<
O
=
D)
@)
%J
@)
£
2
-
@)
-+
%)
D
O

About Us
XY Appearance
Blog
Themes Booking Form Home Page v
e Rental Rates
PR Seminar Room Rental All Rooms Page v
GASES Training Room Rental
Menus
ARRocns Meeting Room Rental sub item Page v
Header
Editor Select All Add to Menu
Seminar Room Rental sub item Page v
A Plugins Posts v
~ Training Room Rental sub item Page v
>
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Screen Options ¥ Help ¥
Menus Manage with Live Preview

Edit Menus Manage Locations

Edit your menu below, or create a new menu.

Pages 8 Menu Name | Site Links . TR

Give your menu a name, then click Create Menu.

1ok t. Name the menu “Site Links”

.-+ 2. Click Create Menu

Conre v B

D
O
-
S
| -
S
D
Q
Q

<

=

»

Q

=
®)

=

G
-

O
9P,
D

O

S
\
N

N
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Menus Manage with Live Preview

Edit Menus Manage Locations

Select a menu to edit: Site Links

Pages v
Posts v
Custom Links A

URL http://facebook.com

Link Text | Facebook

D
@)
(-
qV)
| -
qV)
)
Q.
QO
<
9
%)
O
=
@))
=
D
-
O
) Add to Menu
D)
O

Categories v

.:.
N
N

gl
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Screen Options ¥ Help ¥

— Select or create a new menu.

Let's add a custom link, e.g. a link

M N. i i S M :
R 1o LUk that links to an external partner
website.
Menu Structure
Add menu items from the column on the left. ~| |:||| in the URL and Llnk Text
T PR PE LS 2. Click Add to Menu
Mena'Settings el
Auto add pages Agtp[n.agicall.y-add'n'eW'tbf)-'lé\;e.I ;.)a.\ges to this menu
. Display fo°cét.io.n. . Header Menu (Currently set to: Main Navi)

Footer Menu
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Edit Menus Manage Locations

Select a menu to edit: Site Links
Pages . 4
Posts v
Custom Links A
URL http://
Link Text

Add to Menu
Categories v

4 Select orcreate a new menu.

Menu Name Site Links

Save Menu

Menu Structure

Drag each item into the order you prefer. Click the arrow on the right of the item to reveal additional
configuration options.

Facebook CustomLink ¥

Menu Settings

Auto add pages Automatically add new top-level pages to this menu
Display location Header Menu (Currently set to: Main Navi) .
Footer Menu .
| 4

Llick Save Menu.

S
\
N

gl
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A MyBlog ¥ 4+ New Howdy,

ruyosLw

A monthly archive of your site’s Posts.

VEGIE v
Calendar Front Page 1
Pages
G — A calendar of your site’s Posts. Front Page 2 v
' Forms Categories
Front Page 3 o
Genesis A list or dropdown of categories.
T Custom Menu Footer 1 a We can now select the footer menu
Add a custom menu to your sidebar Footer 1 widget area. Lo we JUSt Created - S|te LIHKS
Themes ' e
Customize ' Custom Menu: Site Links Al . : : -
oot Formidable Form . Continue adding widgets to footer
idgets o’ .
e Display a Formidable Form Title: . o’ R o | 2 aﬂd 3
Site Links
Header Genesis - Featured Page , et Lot
Editor Select Menu v — Select — B N
Displays featured page with thumbnails Main Navi Lo et ’
A Plugins Delete | ClogiiET I RNNA" "
% (e Genesis - Featured Posts R )
‘ ° [ J
4 Tools Displays featured posts with thumbnails Lo .
Footer 2 A v
Settings Genesis - User Profile
'.
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Book a meeting room today.

Here’'s how your footer looks like
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NOW.
SITE LINKS CATEGORIES ADDRESS
FACEBOOK TIPS 137 Cecil Street
UNCATEGORIZED
© Copyright 2017 - All Rights Reserved -
s
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Any styling element that isn't
customisable via an admin panel Is
usually customisable via code.

W) @A MyBlog ¥ 4+ New Howdy, demouser
Help ¥
&% Dashboard i -
Edit Themes Depending on the theme, to style
@ Jetpack . . :
Digital Pro: Stylesheet (style.css) Select theme to edit: Digital Pro 4  Select and customise web elements such
# Posts /* Templates as the text colour, spacing between
Medi Thee hame: Dlgital ko This child theme inherits '
e Theme URI: http://my.studiopress.com/themes/digital/ header and bOdy, font fam”y, font
- Description: Put your words and images at the forefront in an uncluttered design that shows them tomplates from & parent :
ages at their finest. theme, Genesis. size, you most probably would
Author: StudioPress , .
SOTRnnSs Author URI: http://www.studiopress.com/ St(aftuc Front p:%e have to ﬂaVIgate (0 Appearance
ront-page.php
=) Forms . - i I
Version: 1.0.3 TR => Editor and customise the code.
. (functions.php)
Genesis Tags: black, red, white, one-column, two-columns, left-sidebar, right-sidebar, responsive-
layout, custom-colors, custom-header, custom-menu, featured-images, full-width-template, sticky-post, customize.php ¥ .
» Appearance theme-options, threaded-comments, translation-ready, accessibility-ready (lib/customize.php) Here are some h@lprl arthleS'

D)
@)
-
M
| -
M®
D
Q.
Q.
<C
O
=
D)
@)
%J
@)
£
2
-
@)
-+
0
)
O

Themes Template: gen?SiS ou(:i‘t));]c:;?phu?.php)
N Template Version: 2.2 e e https://codex.wordpress.org/
: Li : GPL-2.0+ ib/theme-defaults. | .
bt Liz::: URI: http://www.opensource.org/licenses/gpl-license.php L(“;/_h 2 ’ fTI plh‘:) lndlng Your CSS Styles
Menus */ st * hitps://codex.wordpress.org/CSS
Header
e ditor it Styles e https://codex.wordpress.org/
- HTMLS Reset S Theme Development
K¢ Plugins - Baseline Normalize (styre.css) '
- - Box Sizing ) style-front.css
as Users - Float Clearing . . .
- Defaults style-ie9.css If coding isn't cut out for you, you
/4 Tools - Typographical Elements
5 settings - Headings . may want to outsource them to:
* WWW.codeable.io
® WWW.UPWOrk.com
S
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https://codex.wordpress.org/Finding_Your_CSS_Styles
https://codex.wordpress.org/CSS
https://codex.wordpress.org/Theme_Development
http://www.codeable.io
http://www.upwork.com

Making Your

Site SEQO-

Friendly

Venue Square

Dashboard

Posts

Media

Pages

Forms
Comments
Portfolio Items

Enfold Child

Appearance

A Plugins

Users

Tools

Visual Composer
Settings

Shortcodes

New Theme Options

Add Plugins upload Plugin

Search Results  Featured Popular Recommended  Favorites
Yoast SEO Install Now
Improve your WordPress SEO: More Details

Write better content and have a
fully optimized WordPress site
using Yoast SEO plugin.

By Team Yoast

W W W W7 (1,781)

1+ Million Active Installs

Last Updated: 2 months ago

v Compatible with your version of WordPress

WordPress SEO Nuke
Noob Stuff

Built to extend WordPress SEO by
Yoast plugin by removing some of
the basic noob things like the SEO
color dot and extra columns on
pages and posts.

Install Now

More Details

.

Howdy, demouser B8

Help ¥

Keyword § WordPress SEQO

1,712 items  « ¢ 1 |of58 > »

WordPress SEO Install Now

Comments Plugin _
More Details

The WordPress SEO Comments
Plugin turns comments into search
engine optimized portals to your
blog, new Google SEO entry points
into WordPress sites.

By David Law

Last Updated: 2 weeks ago

W W W 17 (6)

4,000+ Active Installs v Compatible with your version of WordPress

Smart Wordpress SEO Install Now
Boost your wordpress SEO: Full More Details
SEO features Meta Tags,

webmaster tool, Social AuthorShip,
XML Sitemap, Image SEO, Super
Fast Automated SEO

By Purab Kharat

Out of the box, WordPress is already 80 - 90% SEO-friendly. That means, you only have
to take care of the remaining 10 - 20% of on-page ranking factors.

1. Navigate to Plugins => Add New and install “WordPress SEO by Yoast”.

| 44
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WY @A VenueSquare W <+ New ViewPage SEO Theme Options Howdy, demouser B
L‘?j Media elaull Layout - sel in enfola
- Yoast SEO =
|® Pages
Sidebar Setting
All Pages Content: @ * Choose a custom sidebar for this ent
‘ 18 ’
N Add New Default Sidebars .
- a Snippet
_g Skl e Meeting Room Rental - Venue S
= eeting Room Rental - Venue Square ... Footes Satiings
— Comments < @ venuesquare.com/meeting-room-rental TrteeaL !, J Display the footer widgets?
Lt The Perfect Meeting Room Rental For Your Business Needs Description Room is air o -D. she s
i conditioned, with meeting room table and office chairs surrounding. Adequate efault Layous-Sgt '-n."': old CF'| = " "
| Portfolio Items g g e You can click on the Title and Meta
8  fooe """ Description to edit it.
U) Title Bar Settings
® Appearance Eeiic Display the Title Bar with Page Title
O Keyword and Breadcrumb Navigation? )
) - x
5 Plugins Pt Cavorit < Bl o - We recommend putting your target
. Users keywords In them.
D) :
, Content @® No focus keyword was set for this page. If you do not set a focus keyword, no score R
@) Tools Analysis e i Header visibility and transparency
>— (?) Several options to change the header
®) Visual Composer 3 @® The text contains 164 worc?s, thi.s is below the 300 word recommended minimum. Ac transparency and visibility on this
= . more useful content on this topic for readers. page.
= Settings @® No meta description has been specified, search engines will display copy from the Ty
CXU St page instead. il HER
E ® The copy scores 50.8 in the Flesch Reading Ease test, which is considered fairly
vi SEO difficult to read. Try to make shorter sentences to improve readability.
' @ The page title contains 35 characters, which is less than the recommended minimurr
O Slider Revolution of 40 characters. Use the space to add keyword variations or create compelling call-t Featured Image .
action copy.
=] LayerSlider WP Set featured image
A g
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) Ke)’WOI’dSJ/ Url: www.webdesign.com/ecommerce-web-design/

in URL
<head><meta name="description” content="We provide the best and most | O) Design
: affordable commerce web design packages in the market.”></head>
2) Keywords in /b I PR & UX
Meta Description <title>E-commerce Web Design Service</title> 5) LS| KE)’WOI"dS IN
. /h1>E-Commerce Web Design Service</h1> Content Area ') .MObIIe-
= 3) Keywords in / friendly
S Title Tags We provide the best custom e-commerce web design services 6) Quality &
= . |2) Page
L - Uniqueness of L oads Fast
Q 4) Keywords In — Content
oz Subheadings .
o | 3) Page is
=
- 8) Link out to  <h3>Why We Provide The Best Website Design Package</h3> Image Frawlable/
o | K d indexable
> relevant sources Designing a site requires. .. eywor
O : : inserted Into
- if possible .
< P \ Title and/or |4? Incluc!e
S . . Website creation process... Alt Text social sharlng
9) Interlink articles buttons
with relevant \
anchor text \ /) Keywords in Image |5) Https
(Site architecture) ™ | Title & Alt Tags Secure
View our other web design packages ->
=
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>
O
-
R
L?
O
LL|
N
=
%
S
>
®)
£
'
W
=

@& MyBlog @

» Dashboard

Q) Jetpack

# Posts

07 Media

Pages
» Comments

=) Forms

© Genesis

» Appearance

+ New & WPFC

WP Fastest Cache Options

Settings Delete Cache Cache Timeout Image Optimization Premium Exclude CDN

Cache System:
Preload:
Logged-in Users:
Mobile:

Mobile Theme:
New Post:
Update Post:
Minify HTML:

Minify HTML Plus:

v'| Enable

v'| Create the cache of all the site automatically we

v Don't show the cached version for logged-in users

v’ Don't show the cached version for desktop to mobile devices
Create cache for mobile theme

v'| Clear cache files when a post or page is published

v'| Clear cache files when a post or page is updated 6

v'| You can decrease the size of page 9

More powerful minify html

Howdy, demouser il

Having Issues?

* You can create a ticket

WordPress support forum

You can check your site speed via
PageSpeed Insights and get

recommendations on how to
iImprove your site speed.

Some common issues include:

e Optimising your image sizes (use
|peg-optimizer.com ,
compressor.io , and/or select
“save for web” when saving your
images through Photoshop.)

Minify Css: v You can decrease the size of css files €9 ® Leve rag | N g on b rowser cac h | N g
.\:, Plugins Minify Css Plus: More powerful minify css SR .
Combine Css: v Reduce HTTP requests through combined css files € ¢ I\/l | n lfyl n g COd e (e . g . CSS)
RS Minify Js: You can decrease the size of js files
¢~ Tools Combine Js: v Reduce HTTP requests through combined js files (header) €

Settings

WP Fastest Cache

o man
)SE enu

Combine Js Plus:
Gzip:

Browser Caching:
Render Blocking Js:

Language:

Reduce HTTP requests through combined js files (footer)

v'| Reduce the size of files sent from your server "
M Reduce page load times for repeat visitors .

Remove render-blocking JavaScript 6

English :

.
Qy
N

>

You may use the following plugins
with caution (as the plugins may
conflict with your theme or other
plugins):

o WP Super Cache

¢ \WP Total Cache

¢ WP Fastest Cache

Equinet
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https://developers.google.com/speed/pagespeed/insights/
http://jpeg-optimizer.com
http://www.compressor.io

# VenueSquare B 4 New SEO Theme Options Howdy, demouser [

7 Help
| Daton Add Plugins upload Plugin
Posts | Yoast SEO has been updated to version 3.0.7. Click here to find out what's new!
Media
Pages | We've updated our SEO score algorithm. Click here to recalculate the SEO scores for all posts and pages.
() Forms
Comments Search Results  Featured Popular Recommended  Favorites Keyword § woocommerce
Portfolio Items :
2,414 items 1 [of81 > »
Enfold Child
WooCommerce Install Now YITH WooCommerce Install Now

Appearance Ajax Product Filter

WooCommerce is a powerful, More Details
‘ extendable eCommerce plugin that
helps you sell anything. Beautifully.

By WooThemes

More Details

A Plugins

YITH WooCommerce Ajax Product
Filter offers you the perfect way to

Installed Plugins filter all products of your

Add New WooCommerce shop.
Editor By yithemes
(1,415) Last Updated: 3 weeks ago
e Users 1+ Million Active Installs v Compatible with your version of WordPress
(26) Last Updated: 2 weeks ago
/ Tools : : :
70,000+ Active Installs v Compatible with your version of WordPress
Visual Composer
Settings
YITH WooCommerce Install Now COWPM WooCommerce Install Now
<> Shortcodes Ajax Search | $WPML Multilingual - run A
@ More Details Ml reie e el More Details
YITH WooCommerce Ajax Search & L R

The WordPress WooCommerce plugin gives you a free out-of-the-box solution to start an
e-commerce store and process online orders through your WordPress website.

1. Navigate to Plugins => Add New and install “WooCommerce”.
i
) o
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U1 []”) COMMERCE

Once WooCommerce is activated,
Welcome to the world of WooCommerce! you will be taken to this screen.

Thank you for choosing WooCommerce to power your online store! This quick setup _
-+ Click “Let’s Go”
wizard will help you configure the basic settings. It's completely optional and 2 b -

shouldn’t take longer than five minutes.

No time right now? If you don't want to go through the wizard, you can skip and return
to the WordPress dashboard. Come back anytime if you change your mind!

A
Not right now

N
N
N

N
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Page Setup

Your store needs a few essential pages. The following will be created automatically (if

they do not already exist):
O
9 Shop The shop page will display your products.
o e e 00
g i The cart page will be where the customers go to view their
O cart and begin checkout.
(_I) AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA
LL] Checkout The checkout page will be where the customers go to pay for )
0p) their items. N
op) .
L .
Nn_ g Registered customers will be able to manage their account i
O B details and view past orders on this page. i
| °
=

Once created, these pages can be managed from your admin dashboard on the Pages G .

screen. You can control which pages are shown on your website via Appearance > s

Menus. e

. b
Skip this step Continue
»
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Store Locale Setup

Where is your store based? Singapore v
8 Which currency will your store Singapore Dollar ($) v
CT) use? If your currency is not listed you can add it later.
g Currency Position ( Left v
O
@) Thousand Separator :
|
LL
N Decimal Separator
7))
) .
— Number of Decimals 2
an
O ,
5 Which unit should be used for kg -
; product weights?
Which unit should be used for [ cm v

product dimensions?

Skip this step

N
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U [J2) COMMERCE

Page Setup Store Locale Shipping & Tax

Shipping & Tax Setup

If you will be charging sales tax, or shipping physical goods to customers, you can
configure the basic options below. This is optional and can be changed later via

WooCommerce > Settings > Tax and WooCommerce > Settings > Shipping.

Basic Shipping Setup

Will you be shipping products? () Yes, | will be shipping physical goods to customers

Basic Tax Setup I

Will you be charging sales tax? () Yes, | will be charging sales tax oo

AO

Skip this step

.- Click “Skip this step”.

n:.'
ol

g
Equinet
Academy
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Page Setup Store Locale Shipping & Tax ‘Payments Ready!

Payments
WooCommerce can accept both online and offline payments. Additional payment
8 methods can be installed later and managed from the checkout settings screen.
| -
D
g PayPal Standard
@) To accept payments via PayPal on your store, simply enter your PayPal email address below.
O , :
[ PayPal Email Address: .
LLI Lo
7)) . S
) Offline Payments
) .
DL_ Offline gateways require manual processing, but can be useful in certain circumstances or for o
testing payments. SSes :
O
§ Cheque Payments Enable payment via Cheques il
Cash on Delivery Enable cash on delivery :
Bank Transfer (BACS) Enable BACS payments i .

o thissien | [

N
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U] COMMERCE

Page Setup Store Locale Shipping & Tax Payments Ready!

That’s it! You have finished

Your Store is Ready! W Tweet customising the basic settings of
WooCommerce. If you wish to

customise your settings further, you
Want to help make WooCommerce even more awesome? Allow WooThemes to C '
collect non-sensitive diagnostic data and usage information. Find out more. may dO SO via WOOCOm merce =>

. “Settings”.
E: lloy No thanks

........ .-+ Now, let’s create your first product.
Next Steps learsnMore B

[>] Watch the WG, 101 video walkthroughs
Create your first product! 4
Get eCommerce advice in your inbox

[ Follow Sidekick interactive walkthroughs

B Read more about getting started

N
N
N

gl
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WY @ VenueSquare B 4 New SEO Theme Options Howdy, demouser [

Screen Options Help
& Dastiboard Add New Product
Posts . :
Meeting Room Rental Publish
Media
Permalink: http://venuesquare.com/product/meeting-room-rental/ Edit e Dyratt Prendean:
Pages
Advanced Layout Editor ? Status: Draft Edit
(%) Forms
: o, @ Visibility: Public Edit
Comments QJ Add Media = (&) Forms 81| Insert shortcode \Visual Taxt
7 i i) Publish immediately Edit
Portfolio Items B I = = = ¢ — = = = & 8 = B A~ © b
2R X 2 RN AN TR Catalog visibility: Catalog/search Edit
Enfold Child Paragraph v U = A v B O Q E T N @ Enter your product name,

(7] Move to Trash | Publish description, and product category.

WooCommerce Rent our meeting rooms on a per day (full-day) basis.

Products
Product Categories

Products
All Product Categories Most Used
Add Product 5

Categories v'| Meeting Rooms

Tags
+ Add New Product Category

Shipping Classes

Attributes

<>

¥ Appearance — Parent Product Category —

P
Word count: 10 Draft saved at 3:05:42 pm. Add New Product Category

A Plugins

sa Users

-...
N

N
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WY @ VenueSquare B 4 New SEO Theme Options Howdy, demouser i

¥+ Enfold Child Product Data — Simple product = Virtual: Downloadable:
Header visibility and transparency

2] WooCommerce [® General SKU MROO1 © Several options to ;hfahge the hgader
transparency and visibility on this

E’ Products |2 Inventory page.

Regular Price ($) 400 No transparency
Products ﬂ] Shlpplng
Add Product Sale Price ($)
; ¢ Linked Products
Categories Schedule Scroll down and enter your product

Product Hover

Tags S Attributes data e.g. Stock Keeping Unit

Shipping Classes

Hover effect on Overview Pages " "
Attributes ¥ vaneed Do you want to display a hover effect (SKU)’ prlce! quantlty! Short

on overview pages and replace the : :

JY— default thumbnail with the first image d eSC rl ptIOn ) etC J

Product Short Description OF the gaserys
Plugins A No hover effect : .
. Q) Add Media || (@) Forms || [§] Insert shortcode | . Next, set your product image.
sers .
Took B I = = i ¢ — £ = =E LR E X|E A~ O i\
Paragraph v U = A v @l @ Q £ = 4 0 [ Product Image o

Visual Composer

Set product image

Settings 1-Day Meeting Room Rental.

Shortcodes
Product Gallery

SEO
Add product gallery images

Slider Revolution

LayerSlider WP

-...
N

N
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Product Image X

Upload Files Media Library

Images v  Alldates v ATTACHMENT DETAILS
R —— Training-Room.jpg
\ - l. BN February 19, 2016
197 kB
= 1681 x 1117

¢ ot _— . =
Edit Image

Delete Permanently

~Select your product image and
- click “Set product image”.

URL | http://venuesquare.com/w

Title  Training Room

é Caption N
e, 2) Submit Fo.tm & Hc .°
Receive Invoice Rec g .
Alt Text .‘
Description .’.
/4 ...
Slide link .'
Shortcodes Ultimate ..
s SN SO N . e : '
o
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) 4@ Venue Square

#% Dashboard

Posts
Media
Pages

(%) Forms
Comments
Portfolio Items

Enfold Child

WooCommerce

E7 Products

Products

Add Product
Categories

Tags

Shipping Classes

Attributes

> Appearance

A Plugins

sa Users

<+ New SEO Theme Options

Add New Product

Meeting Room Rental

Permalink: http://venuesquare.com/product/meeting-room-rental/ Edit

Advanced Layout Editor

(%] Insert shortcode

Q7 Add Media | (&) Forms

SRS RO S i P { RO R, — et — (/;) \? = ‘ 7

Paragraph v U

Rent our meeting rooms on a per day (full-day) basis.

P
Word count: 10

i

p =

.
B

O

@)

il

i
P
®

Visual Text

Draft saved at 3:05:42 pm.

Howdy, demouser [

Screen Options Help

Publish

Save Draft Preview

? Status: Draft Edit
@ Visibility: Public Edit
fiil] Publish immediately Edit

Catalog visibility: Catalog/search Edit

O Move to Trash

Product Categories

All Product Categories Most Used

v'| Meeting Rooms

+ Add New Product Category

— Parent Product Category — H

Add New Product Category

gl
Equinet
Academy
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Howdy, demouser B Q

WY @ VenueSquare ¥ Customize ¥ 4+ New  EditProduct @ SEO Theme Options E Edit Form

E N F O L D Home All Rooms Rental Rates Booking Form Blog About Us Contact Us Q

You are here: Home / Shop / Meeting Rooms /Meeting Room Rental

Shop

Meeting Room Rental Your product is now in stock.
$400.00 Let's test out the order process.

1-Day Meeting Room Rental.

; ’ " 4C|ICK“AddtOCart”

SKU: MRO0O1 Category: Meeting Rooms

Description Reviews (0)
CONTACT PAGE
Name Product Description

Rent our meeting rooms on a per day (full-day) basis.

Email

4
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#% Venue Square ¢ Customize B 4+ New ( EditProduct @ SEO Theme Options (i) Edit Form Howdy, demouser [l Q

E N F O L D Home All Rooms Rental Rates Booking Form Blog About Us Contact Us Q =

You are here: Home / Shop / Meeting Rooms /Meeting Room Rental

Shop

“Meeting Room Rental” has been added to your cart. i LR

- Click “View Cart”.

Meeting Room Rental

$400.00

1-Day Meeting Room Rental.

SKU: MRO01 Category: Meeting Rooms

Description Reviews (0)

CONTACT PAGE

Al san

4
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venue >quare N Uustomize == NNew Ql '.;- W neme UpLIo QIt W YVE OIMDOSE r Qi OrTT 'ooo-'o Br B
E N FO L D v Home All Rooms Rental Rates Booking Form Blog About Us Contact Us Q =
Cart You are here: Home / Cart
CONTACT PAGE
PRODUCT PRICE QUANTITY TOTAL
N [
- o Coupons can be created via
® E Meeting Room Rental $400.00 - 1 + $400.00 ( 0 (0 0
WooCommerce” => “Coupons”.
Coupon code Apply Coupon
......... -++*Click “Proceed to Checkout”.
CART TOTALS Ph.o?e .............
SUBTOTAL $40000 et
TOTAL 840000 o aeeescrttt Message
Z
Submit
.
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) @ VenueSquare ¥ Customize

ENFOLD

Checkout

& 4+ New

Have a coupon? Click here to enter your code

e

? Edit Page

® SEO Theme Options

Home All Rooms

Billing Details

First Name *

Company Name

Email Address *

equinetsg@gmail.com

Country *

Singapore

Address *

Street address

Last Name *

Phone *

Additional Information

Order Notes

Notes about your order, e.g. special notes for delivery.

Edit with Visual Composer

Rental Rates

=) Edit Form

Booking Form

Howdy, demouser

Blog AboutUs ContactUs Q ¥

You are here: Home / Checkout

CONTACT PAGE

Name

Email

Message

Submit

.-+*Enter your billing details.

Qy
N

—
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3 @ VenueSquare ¥ Customize ¥ 4+ New ( Edit Page SEO Theme Options Edit with Visual Composer (=) Edit Form Howdy, demouser
ENFOLD Home All Rooms Rental Rates Booking Form Blog About Us Contact Us Q =
How to Conduct an Convincing Seminar
Your Ordel’ Hello world!
PRODUCT TOTAL
Meeting Room Rental x 1 $400.00 RECENT COMMENTS
SUBTOTAL $400.00 Mr WordPress on Hello world! Upon SeleCtlng PayPal and Cllelng
TOTAL $400.00 "Place order”, your customers will
ARCHIVES .. betaken to the PayPal Chegkout
Fobruary2016 Leett page (offsite) where they will make
@ “omewew . e payment. The funds will then go
e e e T e P o | e L .A.T.E;E;);RIES d | re Ctly I nto yo ur PayPal accou n‘t .
....... Tips
....... Uncategorized
o —————
() PayPal VISA ols_gja E !ss W.hz:t is .PszyE’aI?o oo
....... META
....... Site Admin
....... Log out
% Entries RSS
Comments RSS
WordPress.org
.
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&) #A Venue Square

@& Dashboard

Home

Updates

A Posts

07 Media

M Pages

(%) Forms

® Comments
A Portfolio Items

£+ Enfold Child

3 WooCommerce

£’ Products

> Appearance
A Plugins

ea Users

4 Tools

Visual Composer

Settings

® 0 <4 New SEO Theme Options

WordPress Updates

Last checked on February 19, 2016 at 3:52 pm.

Check Again

Howdy, demouser [

Help

You have the latest version of WordPress. Future security updates will be applied automatically.

If you need to re-install version 4.4.2, you can do so here or download the package and re-install manually:

Re-install Now Download 4.4.2
Plugins
Your plugins are all up to date.
Themes

Your themes are all up to date.

It Is important to keep your WordPress version, themes, and plugins updated to avoid
any malicious attacks. We will also go through measures to take to secure your site as
much as possible.

|64
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\? # VenueSquare B 4 New SEO Theme Options Howdy, demouser [

Help
& Dashboard Add Plugins upload plugin
Posts
Search Results  Featured Popular Recommended  Favorites Keyword § duplicator
Media
Pages 1,226 items 1 |of41[5 || »
(%) Forms
Duplicator Install Now {}O {:} Duplicator / Cloner / Install Now
Comments O {J%O{"/ Migrator *** PRO

Duplicate, clone, backup, move More Details More Details

Portfolio Items and transfer an entire site from DUPL'CATOR features for FREE *** N aV| g ate to ‘ Pl U g | NS ’ => “Ad d
CH 0

one location to another.

Enfold Child :{} -y Duplicator clone plugin can y . y . y
DUPLICATOR 8y LifelnTheGrid 'OO ot duplicate, backup website, clone N eW aﬂ d N Stal | th e D U pl ICatOr
WooC website or migrate WordPress | .
Spdlllo website from one hosting place to p U g In.
’ Products (982) Last Updated: 1 week ago another for FREE!
600,000+ Active Installs v Compatible with your version of WordPress By www.wpadm.com
> Appearance
A Plugins (21) Last Updated: 2 days ago
: 2,000+ Active Installs v Compatible with your version of WordPress

Installed Plugins
Add New
Editor Trash Duplicate and 301 Install Now Cleanup Duplicate Meta Install Now
ea Users Redirect More Details Cleanup Duplicate Meta gives you More Details

a tool to check for and delete
duplicate Post and/or User Meta
entries in the database tables.

Find and delete duplicates posts,
pages, custom post and 301
redirect to the new or old URL.

4 Tools

Visual Composer

Rv Snlwin Infnforh By WP Developers Club and Tonya

-...
N

N
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@ VenueSquare ¥ 0 < New SEO Theme Options Howdy, demouser [

@ Dashboard Packages » All

Posts Bulk Actions v = Apply = & i All Packages Create New

Media 3
Pages
(%) Forms

Comments B No Packages Found.
Click the 'Create New' button to build a package.

Portfolio Iltems

*. Once installed and activated, click

Enfold Child Please visit the help page for additional support » .
Create New”.

WooCommerce

= Products

Appearance

v Plugins

Users

Tools

Visual Composer
Settings

Shortcodes

SEO

N
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\‘:‘/ @ VenueSquare ¥ 0 < New SEO Theme Options Howdy, demouser

&2 Dashboard Packages » New
A Posts Scan Build  Step 1: Package Setup M All Packages Create New
Media
Pages & Requirements: Pass 5
(\ ) Forms ey (#' Notes
Comments 20160219_venuesquare
Portfolio Items
Enfold Child & SLOrage = . C“Ck (6 Nextu
WooCommerce () Archive v >
7 Products °..
¥ Installer ..

Appearance

Plugins Reset

Users

Tools

Visual Composer

Settings

Shortcodes

SEO

N
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V) @ Venue Square
(=) Forms

= New SEO Theme Options

Howdy, demouser

Comments £ Server Diagnostics
Portfolio Items » Web Server v Good
Enfold Child » PHP Setup v Good
» WordPress A Warn
WooCommerce
) Proticte (&) Archive
fi Files 126.18MB
Appearance
» Total Size v Good
Plugins : -
 Name Checks v Good Click on the check box and click
Users » Large Files v Good o ® '... “B ' 1]
R (X uild”.
Tools St R |
Visual Composer &8 Database 2.39MB e dai gey
Settings > Total Size v Good AR e
Shortcodes » Table Details v Good Lo ° A
Name: equineta_wp920 e’ ) S0
§4 SEO Host: localhost Lo 5
Build Mode: PHP (slow) e o ® 028 3
«’ Duplicator e’ e
Packages | A warning status was detected, are you sure you want to continue? - *
Settings Scan checks are not required to pass, however they could cause issues on some systems. e 5
Tools Please review the details for each warning by clicking on the detail link. 3%
Help g
About
N
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, # VenueSquare ¥ 0 < New SEO Theme Options Howdy, demouser.

3 Dashtioard Packages » New
Posts Step 3: Build Package B All Packages Create New
Media : : . :
o . That's it! Your entire site is now
B s backed up. Be sure to download
o (¥ Package Completed the two files to your computer.

Portfolio ltems

Enfold Child

4 We've included a free step-by-step

R tutorial on how to restore a
Duplicator backup file here:

WooCommerce

=7 Products [All Packages ]

Appearance

v Plugins

Users

Tools

Visual Composer
Settings

Shortcodes

SEO

N g
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https://www.equinetacademy.com/wordpress-backup-migration-tutorial-duplicator/

Hardening Your Website Security

> QGet a reliable hosting provider that keeps server software
updated and recent.

> Keep regular backups of your database and site files.
> Free your computers of virus, spyware, and malware.

> Ensure you have the latest CMS software version.

D)
@)
-
qv]
-
)
-+
=
Q]
=
%)
O
)
X
@)
M®
an
)
=
D)
@)
%)

> Use strong passwords and login through HT TPs.

> Install security plugins such as WordFence.
n

N
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